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Foreword

HEC-GeoRAS is a package of scripts for application with
ARC/INFO, a general purpose Geographic Information System
software program developed and copyrighted by Environmental
Systems research Institute, Inc., Redlands, California.  HEC-
GeoRAS is written in ‘arc macro language’ (AML) ARC/INFO’s
scripting language.

The HEC-GeoRAS package AML routines were developed by the
Hydrologic Engineering Center (HEC). The data extraction,
import, and export algorithms were written by Thomas A. Evans. 
The user interface was written by Cameron T. Ackerman under the
direction of  Gary W. Brunner and Thomas A. Evans.  Vernon R.
Bonner was the Training Division Chief and Darryl Davis was the
Director during the development of HEC-GeoRAS.

This manual was written by Cameron T. Ackerman.  Appendix B
was written by Thomas A. Evans and Gary W. Brunner. 

  
The Hydrologic Engineering Center would like to acknowledge the
Honolulu District and Sacramento District for the data sets used in
the examples.  Note that the example figures in this manual are
provided for illustrative purposes only and are not to be taken
as  hydraulically accurate.
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C H A P T E R  1

Introduction

HEC-GeoRAS is a package of ARC/INFO macros specifically designed to
view and manipulate geospatial data for use in the Hydrologic
Engineering Center’s River Analysis System (HEC-RAS).  The graphical
user interface allows users with minimal GIS experience to create a HEC-
RAS import file containing geometric attribute data from an existing
digital terrain model (DTM).  Water surface profile data exported from
HEC-RAS simulations may also be viewed using HEC-GeoRAS.  The
HEC-GeoRAS macros are written in the arc macro language (AML) and
require the ARC/INFO program with the TIN extension.

The current version creates an HEC-RAS import file containing river,
reach and station identifiers; cross section cut lines, cross section surface
lines; cross section bank stations, and downstream reach lengths for the
left overbank, main channel, and right overbank.  Roughness coefficients
and hydraulic structure data are not written to the import file.

Chapter 1 discusses the intended use of HEC-GeoRAS and provides an
overview of this manual.

Contents

� Intended Application of HEC-GeoRAS

� Overview of Requirements

� Overview of the User Interface

� User’s Manual Overview

Intended Application of HEC-GeoRAS

The intended use of HEC-GeoRAS is to create a import file of geometric
attribute data for use in HEC-RAS and to view water surface profile data
exported from RAS.  The import file is created from geometric attributes
extracted from an existing DTM.  The current version of HEC-GeoRAS
requires a DTM represented by a triangulated irregular network (TIN). 
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Geometric data is extracted from the DTM by intersecting a series of line
coverages referred to, herein, as RAS Coverages.  The RAS Coverages are
created to represent the geometric attributes required to develop a HEC-
RAS model: cross section geometry and stationing, bank stations, and
reach lengths.  

After the geometric data file has been imported into RAS, the geometric
data set must be completed before performing hydraulic computations. 
Results from RAS simulations may be written to a data exchange file. The
exported water surface profile data may then be imported back to HEC-
GeoRAS for spatial analysis.  Inundation mapping options are provided to
view the inundation extent and flow depth.

Overview of Requirements

HEC-GeoRAS provides a graphical user interface that allows users with
limited geographic information systems (GIS) experience to create, edit,
and view geometric attribute data for use with HEC-RAS.  Knowledge of
ARC/INFO, ARCEDIT, and ARCPLOT is advantageous, but not
necessary.  Users, however, should have experience modeling with HEC-
RAS and have a thorough understanding of river hydraulics to properly
construct the necessary coverages.

Hardware and Software Requirements

HEC-GeoRAS is a package of macros written in AML for use in
ARC/INFO.  ARC/INFO Version 7.1 or higher may be run from the
UNIX operating system or Windows NT.  The TIN feature of ARC/INFO
is also necessary to use HEC-GeoRAS.  ARC/INFO is supported by the
Environmental Systems Research Institute (1998).

Data Requirements

At this time, HEC-GeoRAS requires a DTM in the form of a triangulated
irregular network (TIN). The DTM must be a continuous surface that
includes the bottom of the river channel and includes all of the floodplain
to be modeled.  Because all cross-section data will be extracted from the
DTM, only high resolution DTMs should be considered for hydraulic
modeling.  HEC-GeoRAS does not build a TIN or provide tools for
building a TIN.
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Overview of the User Interface

The interface for HEC-GeoRAS is divided into three user environments:
project management, preprocessing, and postprocessing.  The project
manager allows the user to maintain projects and provides access to the
pre- and postprocessing windows.  Preprocessing options include windows
for creating a Contour Coverage from a DTM, creating and editing RAS
Coverages, and creating the HEC-RAS Import File.  Postprocessing
windows allow the user to read in a HEC-RAS Export File, select water
surface profiles data to analyze, and view the extent and depth of
inundation for selected profiles. 

User’s Manual Overview

This manual provides detailed instruction for using HEC-GeoRAS to
create an import file for performing hydraulic modeling with HEC- RAS
and viewing exported water surface profile data from RAS simulations. 
The manual is organized as follows:

� Chapter 1-2 provides an overview of HEC-GeoRAS, as well as
instructions for getting started.

� Chapter 3 provides a detailed overview of HEC-GeoRAS.

� Chapter 4 discusses the project manager in detail.

� Chapter 5 describes RAS preprocessing requirements and detailed
instruction for developing a HEC-RAS Import File

� Chapter 6 describes RAS postprocessing options for importing the
HEC-RAS Export File and viewing water surface profile data.

� Chapter 7 provides an example application of HEC-GeoRAS.

� Appendix A contains a list of references.

� Appendix B contains a sample import file and export file.
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C H A P T E R  2

Installing HEC-GeoRAS 

The installation procedure for HEC-GeoRAS differs between operating
systems.  However, automated procedures for both Windows NT and
UNIX operating systems will assist the user in installing the package of
ARC/INFO macros.

This chapter discusses the ARC/INFO requirements and installation
instructions for the Windows NT and UNIX operating systems.

Contents

� Hardware and Software Requirements

� Windows NT Installation

� UNIX Installation

� HEC-GeoRAS Files

Hardware and Software Requirements

Before installing HEC-GeoRAS, ARC/INFO Version 7.1 or higher,
including the TIN extension, must be installed on the host server.   Beyond
the hardware and software required to run ARC/INFO, HEC-GeoRAS has
minimal additional requirements:

� A mouse.

� A hard disk with 2 megabytes of free space for the HEC-GeoRAS
package.

� Disk space for the DTM and RAS Coverages.
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The user must also know where to find the ARC/INFO directory before
continuing. 

Note:  If ARC/INFO is reinstalled, HEC-GeoRAS must be reinstalled
afterwards.  

Windows NT Installation

HEC-GeoRAS must only be installed on the ARC/INFO server.  There are
two principle steps to installing HEC-GeoRAS: (1) HEC-GeoRAS must be
installed from the setup program and (2) System Environment Variables
must be set. 

The installation procedure copies a macro into the preexisting directory
structure of ARC/INFO; therefore, if ARC/INFO is ever reinstalled, HEC-
GeoRAS must be reinstalled.

To install HEC-GeoRAS from Windows NT, complete the following:

1. Know where ARC/INFO is installed.

2. Insert the HEC-GeoRAS 1.0 disk into the drive.

3. From the window explorer, open the HEC-GeoRAS folder.

4. Double click Setup.exe.

5. Follow the setup instructions that appear on the screen.

6. Set the Environment Variables.

Installing HEC-GeoRAS requires the user to know the directory where
ARC/INFO is installed.  This directory is identified as the Destination
Directory during installation.  Based on the location of the Destination
Directory, a parallel directory Arc4HEC will be created to install HEC-
GeoRAS.  As well, the file georas.aml will be copied to the directory
Destination Directory\atool\arc.
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Setting Environment Variables (Windows NT)

To set the Environment Variables, do the following:

1. Press the Start ��Settings �� Control Panel from the Windows NT
menu bar.

2. From the Control Panel, open the System controls and choose the
Environment tab.

3. Set the Variable and Value and listed below.

Variable Value

CANVASCOLOR WHITE

CROSSHAIRCOLOR MAGENTA recommended

ARCPANZOOM ON

ARCWINDWSTATS ON recommended

ARCINFOFONTNAME COURIER NEW recommended

ARCINFOFONTSIZE 8 recommended

UNIX Installation

HEC-GeoRAS must only be installed on the ARC/INFO server. 
ARC/INFO must be in place and the ARCHOME environment variable set
before HEC-GeoRAS can be installed.  The installation procedure writes
one file in the ARC/INFO install area (in the $ARCHOME/atool/arc
directory), and creates a new directory parallel to the ARC/INFO install
directory (i.e., one level above $ARCHOME).  You must have write
privilege in these directories to perform the installation.  Also note that if
you reinstall ARC/INFO, you will need to copy the HEC-GeoRAS startup
macro to the new atool/arc subdirectory.
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There are two principle steps to installing HEC-GeoRAS: (1) HEC-
GeoRAS must be installed using the install program and (2) System
Environment Variables must be set. 

To install HEC-GeoRAS on a Unix system, complete the following:

1. Execute the installation script: 

<path_to_CD_ROM>/unix/install

(On most Sun Solaris systems, this would be

/cdrom/cdrom0/unix/install)

2. Set the Environment Variables (see next section).

(Alternatively, you can cop the files “install” and “georas.tar” from the unix
directory on the CD-ROM to any directory on the file system and run the
install program from there.  Note that the install script and the georas.tar
file must be located in the same directory.)

Installing HEC-GeoRAS requires that the ARCHOME environment
variable be set for the user doing the installation.  The install program will
exit if this variable is not set (you can’t run ARC/INFO without this
variable, either).

Setting Environment Variables (UNIX)

To set the Environment Variables, add the following lines to the .cshrc file
of all HEC-GeoRAS users.

setenv CANVASCOLOR WHITE
setenv ARCPANZOOM ON
setenv CROSSHAIRCOLOR MAGENTA
setenv ARCWINDWSTATS ON
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Figure 2.1 HEC-GeoRAS directory structure

HEC-GeoRAS Files

HEC-GeoRAS files are copied under the Arc4HEC\GeoRAS directory. 
The startup macro georas.aml is copied into the arcexe\atoolarc directory
established when installing ARC/INFO.  The directory structure is shown
in Figure 2-1.

A complete list of HEC-GeoRAS files is presented below.

Directory Filename

\aml *.eaf (amls) *.emf (menus)

crosspoint
get_profile_list
raspost_fld
raspost_read
raspost_top_gui
raspost_trim
raspost_wse
rasprep_banks
rasprep_label_xs
rasprep_reach
rasprep_write_xs
reachxyz
streamroute

label_xs
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Directory Filename

\gui *.eaf (amls) *.emf (menus)

check_covers
contour
create_importfile
draw_covers
edit_aat
editor
environment
getcolor
import_rasfile
new_cover
printmap
project
selection
wsp
wsp_draw
wsp_drawmaker
wsp_menumaker

about
check_covers
contour
create_importfile
edit
edit_aat
edit_bar
getcolor
import_rasfile
new_cover
printmap
printmap_bar
printsetup
printtext
ras_bar
ras_form
save_as
snap
wap_draw_bar

*.text

help_contour
help_editaat
help_editor
help_getcolor
help_importras
help_mapping
help_printing
help_prjmgr
help_writeras

other

blue256 
georas.lin
georas.shd
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Directory Filename

\gui\icons *.icon

about
add
arrows
asterisk16
attributes
contour
copy
cut
delete
export32
flip
font16
geom32
get16
import32
inundation32
move
open
open16
paint16
pan16

save
select_all
select_many
select_one
snap
snapenv
split
switch
undo
unselect_all
unselect_many
unselect_one
unsplit
vertex_add32
vertex_del32
vertex_move32
zoomextent16
zoomfull16
zoomin16
zoomout16

\lib *.aml *.menu

2button
disp_help
get_routines
getcover
getfile
getitem
gettin
getworkspace
msconfirm
msinform
msresponse
msresponse2
msworking

getcover
getfile
getitem
gettin
getworkspace
msconfirm
msinform
msresponse
msresponse2
msworking

\bin RASFilter.exe

\arcexe\atool\arc georas.aml
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C H A P T E R  3

Working with HEC-GeoRAS - An Overview

HEC-GeoRAS is a package of arc macro language (AML) macros that
allows the user to view and process geospatial data in ARC/INFO through
a graphical user interface (GUI).  The user can create a geometric attribute
data file for import into HEC-RAS and view inundation maps from
exported RAS water surface profile data.

To create the import file, the user must have an existing digital terrain
model (DTM) of the river system.  Currently, the DTM must be
represented by a TIN.  The user creates a series of line coverages pertinent
to extracting the geometric attributes from the DTM.  A map of the terrain
contours is created to help the user lay out the line coverages.  The line
coverages created are the Main Channel Invert, Main Channel Bank
Stations (optional), Overbank Flow Paths (optional), and Cross Section
Cut Lines and are referred to, herein, as the RAS Coverages.  

Water surface profile data exported from HEC-RAS simulations are read
into HEC-GeoRAS and processed.  The processed water surface profile
coverages may then be viewed.

The collection of the DTM, Contour Coverage, RAS Coverages, and
processed water surface profile coverages is termed a project.

Chapter 3 provides an overview of the steps in developing a HEC-GeoRAS
project.  Chapters 4-6 more completely discuss project development.

Contents

� Getting Started

� Developing the HEC-RAS Geometric Import File

� Running HEC-RAS

� Viewing the HEC-RAS Exported Water Surface Profiles

� Printing Map Results
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Figure 3.1 HEC-GeoRAS Project Manager Window

� Exiting HEC-GeoRAS

Getting Started

Start up ARC/INFO and change directories to the workspace containing
your DTM using ARC/INFO’s WORKSPACE command.  WORKSPACE
is similar to cd on UNIX or at the DOS prompt. Type HEC-GeoRAS.

The main window for HEC-GeoRAS is the project manager window.  The
project manager window allows the user to establish and manage projects
and gain access to the preprocessing and postprocessing components.  The
HEC-GeoRAS Project Manager is shown in Figure 3.1.

At the top of the project manger window is a menu bar.  As shown in
Figure 3.2, the following menus are available:
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Figure 3-2 HEC-GeoRAS Project Manager options

File: This menu is used for file management.  Options under the File menu
include: New Project; Open Project; Save Project; Save Project As;
Rename Project; Delete Project; Command Line; and Exit.

RASPrep: This menu is used for preprocessing.  Preprocessing options are
Create Contour Coverage; Create/Edit RAS Coverages; and Create RAS
Import File.
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RASPost: This menu is used for postprocessing.  Postprocessing options
are Import RAS Export File and Inundation Mapping.

Help: This option allows the user to get on-line help.

The project window also includes buttons for frequently used options.  The
description of the button options is shown in Figure 3.2.  A description of
the button’s function is displayed at the bottom of the window by selecting
the button and pressing the right mouse button.  The message box is
delineated by a recessed message box in windows on Windows NT systems
but not on UNIX systems. 

The Digital Terrain Model input field will only allow the user to enter the
name of an existing TIN.  The other coverage input fields will only allow
the user to type in the name of existing line coverages.  To import existing
coverages, select them using the browser, and they will import when the
editor is invoked. Clicking the right mouse button over an input field
invokes a selection list of all the valid data sets in the current workspace.  

Developing the HEC-RAS Import File

The main steps in developing a HEC-RAS Import File are as follow:

� Starting a new project

� Creating a Contour Coverage

� Creating/Editing RAS Coverages

� Creating a RAS Import File

Starting a New Project

The current ARC/INFO workspace (or current directory) was established
before starting HEC-GeoRAS using the WORKSPACE command. 
Therefore, the default directory will be the current directory and the
project, as well as all newly created coverages, will be saved in the default
directory.  To save the coverages to a different directory, the entire
pathname must be given.  

To start a new project, go to the File menu on the HEC-GeoRAS Project
Manager and select New Project.  The response window shown in Figure
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Figure 3.3 New Project window

3.3 will be displayed.  Enter the name of the new project.  The file
extension .prj will be added to the project name.  The user is not allowed
to change the file extension.

After specifying the project name, press OK .  If the project name is in
conflict with a currently existing project, a message will appear asking the
user if the project is to be overwritten.  Pressing the Cancel button will
return the user to the project manager.

Creating the Contour Coverage

After a new project is created, the DTM of the river basin must be selected.
Press the  button to the right of the input field to invoke a data set

browser.  Select the DTM using the browsing options.  Alternatively, if the
DTM is in the current directory, press the right mouse button while the
cursor is over the Digital Terrain Model input field and select the DTM
from the popup list.  At this time, only TINs may be selected.

Next, the Contour Coverage is created from the DTM by selecting Create
Contour Coverage from the RASPrep menu on the project manager. 
This will bring up the Create Contour Coverage window shown in Figure
3.4.

After entering the Contour Coverage name and the Contour Interval, the
coverage is created by pressing the Create Contour Coverage button. 
The contour coverage name must be 13 characters or less.  The default
Contour Interval of 1.0 unit may be edited by clicking in the input field. If
the interval is too fine in relation to the resolution of the DTM ARC/INFO
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Figure 3.4 Create contour coverage window

will not create the Contour Coverage.  If the interval specified is too large,
the Contour Coverage created will provide an inadequate description of the
land surface for the user when creating RAS Coverages. Pressing the
Cancel button returns the user to the project window.

Creating RAS Coverages

The next step is to create the four RAS Coverages that will be used to
extract geometric data from the DTM.  The line coverages to be created
are the Main Channel Invert, Main Channel Banks (optional), Flow Paths
(optional), and Cross Section Cut Lines.  Select Create/Edit RAS
Coverages from the RASPrep menu on the project manager to bring up
the Edit RAS Coverages window, shown in Figure 3.5.  The Edit RAS
Coverages window will appear with a display window.  The windows may
be moved as desired.  The display window may be resized to the user’s
preference, as well.  RAS Coverages are created and edited in ARCEDIT
which may take a few seconds to load.

From the Edit RAS Coverages window select the Ground Contours
checkbox and press Refresh Display, to draw the Contour Coverage
(created earlier) in the editing window.  If the terrain is not represented
appropriately, create the Contour Coverage again, using a different
contouring interval.  Coverages are selected and drawn in the display
window to assist the user in creating the RAS Coverages.
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Figure 3.5 Edit RAS Coverages window

The following section provides instructions for creating the RAS
Coverages.  For a more detailed discussion on creating RAS Coverages
using the editing tools  refer to Chapter 5.

Main Channel Invert.  The Main Channel Invert Coverage should be
created first.  From the Edit RAS Coverages window, select the MC
Invert  choice to invoke the window shown in Figure 3.6.  Enter the name
of the new coverage and press Create New Coverage.  The coverage
name must be 13 characters or less.  Pressing the Cancel button will return
the user to the Edit RAS Coverages window.

After pressing the ADD ARC button from the Edit Tools palette, cross-
hairs will appear over the editing window.  Draw the river reaches one by
one, from upstream to downstream, using the mouse.  Each reach is
represented by an arc.  An arc is defined by a line containing an upstream
and downstream node.  A series of vertices may separate the nodes. Each
reach may contain no more than 500 points (2 nodes with 498 vertices). 
To create a node, place the cross-hairs at the desired node location and
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Figure 3.6 New coverage window

Figure 3.7 Stream and reach identifier window

press the right mouse button.  To create a vertices, press the left mouse
button.

After drawing each river reach, the window shown in Figure 3.7 will
appear to allow the user to supply the River Name and Reach Name.  The
? button invokes a selection list of river names previously entered for the
current coverage and may be useful for rivers with many reaches. Reach
names for the same river must be unique.  River and reach names may be
up to 16 characters long.   Pressing OK  will save the entered names. 
Cancel will quit the window without saving the names.  

After the river network coverage has been completed, save the coverage by
selecting Save from the File menu.

Main Channel Banks.  Select the MC Banks choice from the editor.  After
supplying the coverage name, create the Main Channel Banks Coverage by
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pressing the Create New Coverage button from the new coverage
window.  

Use the ADD ARC button from the Edit RAS Coverages window to draw
the location of the channel banks.  Separate arcs should be used for each
bank of each river.  Bank lines from tributary rivers may overlap the bank
lines of the mainstem.  Creating the Main Channel Banks Coverage is
optional.

Flow Paths.  Create the Flow Path coverage by selecting the FlowPath
choice, on the editor and entering the coverage name.  If the Main Channel
Invert Coverage already exists, the flow path defining the main channel will
be copied to the edit coverage. Add arcs using the ADD ARC button for
the hydraulic flow path in the left overbank, right overbank and main
channel (if necessary).  Be sure to check that the flow paths are drawn
from upstream to downsteam.  Creating the overbank flow path coverage
is optional. 

Cross Section Cut Lines.  Create the new Cross Section Cut Lines
Coverage by selecting the Cut Line choice and entering the coverage
name.  Add cut lines using the ADD ARC option where cross-section data
should be extracted from the DTM.  Each cut line is represented by an arc
drawn from the left overbank to the right overbank when facing
downstream.  Cut lines must cross the main channel only once and no two
cross sections may intersect.  Cross section cut lines are multi-segment
lines that should be drawn perpendicular to the flow lines.

When finished creating the RAS Coverages, select Exit  from the File menu
to quit from the Edit Coverage window. 

Creating a RAS Import File

The RAS Coverages are used to extract geometric attribute data from the
DTM.  After creating the RAS Coverages, select Create RAS Import File
from the RASPrep menu on the project manager.  The window shown in
Figure 3.8 will be displayed.

Check that the coverage names are correct and select the DTM sampling
interval method.  Enter the import filename and press the Create Import
File button to proceed. Cancel dismisses the window and returns the user
to the project manager.
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Figure 3.9 RAS Coverage Status window

Figure 3.8 Create RAS Import File window
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Once the Create Import File button is pressed, the RAS Coverage
attributes will be checked for missing data.  Progress updates will be
displayed in the Create RAS Import File status window shown in Figure
3.9.  The user will be asked to verify updates to the geometric attribute
data before the import file is written.  If any data is missing, the user will be
prompted to return to the editor to make the appropriate changes.

Running HEC-RAS

After importing the geometric data extracted from the GIS, completion of
hydraulic data will be necessary.  Hydraulic data that is not imported
includes roughness coefficients, expansion and contraction losses, and
hydraulic structure data.  Complete the required data entry before running
any simulations for your hydraulic model.  For a more complete discussion
on importing geometric data refer to the HEC-RAS User’s Manual,
Chapter 13 (Hydrologic Engineering Center, 1998).

After running various simulations in HEC-RAS, export the water surface
profile results.  For a more complete discussion on exporting GIS data
refer to the HEC-RAS User’s Manual, Chapter 13 (Hydrologic
Engineering Center, 1998).

Viewing the HEC-RAS Exported Water Surface
Profiles

The main steps in viewing HEC-RAS exported water surface profiles are
as follow:

� Importing a RAS Export File

� Viewing Inundation Extent and Depth

Importing a RAS Export File

Import the exported RAS data file by selecting Import RAS Export File
from the RASPost menu.  The window shown in Figure 3.10 will appear. 
Specify the file (*.gis) to import and enter the name of a new coverage that
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Figure 3.10 Import GIS File window

Figure 3.11 Create mapping coverages window

will be created.  The new coverage will contain the water surface
elevations for each profile (selected later) at each cross section.  Press OK

to import the data file or Cancel to quit.

Importing the GIS data file results in creating an index file
(tempindex9999) of the water surface profile names.  The index file is
written to the current workspace, and will be referred to as the user creates
water surface coverages for mapping.  Currently, water surface profile
names must be 11 characters or less (including spaces). (Caution: HEC-
RAS allows the user to provide water surface profile names up to 16
characters long when creating the export file.)

Pressing OK  will invoke the window, previously written to the current
workspace (filename wsp.menu) displayed in Figure 3.11.  From the
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window, select the water surface profiles coverages to create and enter the
grid-cell resolution for the associated depth grid.  The grid-cell resolution
refers to the dimensions of a square cell having a single water depth as
averaged value of the surrounding depths.  Press OK  to create the
coverages or Cancel to quit.

Two coverages will be  created for mapping each water surface profile.  A
polygon coverage having the prefix f_ and a grid having the prefix d_
followed by the water surface profile name.  A TIN having the prefix t_
will be temporarily created, but will be deleted after the water surface
profile processing is complete.  Underscores replace any blanks in the
water surface profile names.   The coverages are created in the current
workspace.

Viewing Inundation Extent and Depth

The extent of inundation and flow depth grids may be viewed by selecting
Inundation Mapping  from the RASPost menu on the project manager. 
The Inundation Mapping window shown in Figure 3.12 will be displayed on
the screen along with a viewing window.  Inundation mapping options are
performed in ARCPLOT, which may take a few seconds to load.

Select the water surface profile data to be displayed by selecting the
corresponding Fill  and Bndry checkboxes.  Press Refresh Display to view
the extent of inundation for the various profiles. Selecting Bndry will map
an outline of the inundation polygon, while checking Fill  will color the
entire polygon.

To view the variation in depth for a profile, select a Depth Grid by right
clicking over the input box.  A popup menu will appear and allow the user
to select from the list of available grids.  Next from the Display choice,
select Grid and press Refresh Display.  The variation in depth for the
selected profile will be displayed as shades of blue.  To interactively
determine the water depth at a certain location, press the Depth? button. 
Use the cross-hairs displayed to select the location with the left mouse
button.  The water depth is displayed to the right of the Depth? button. 
Press the right mouse button to finish selecting locations.

When finished viewing the water surface profile coverages, choose Exit
from the File menu to quit from the Inundation Mapping window and exit
ARCPLOT.  
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Figure 3.12 Inundation Mapping window

 Printing Map Results

Maps viewed using the Inundation Mapping window option may be printed
using the options provided by Print Map window.  To access the Print Map
window select Print  from the File menu on the Inundation Mapping
window.   The Print Map window shown in Figure 3.13 will be displayed.

Using the page presentation options provided in concert with Preview to
prepare the map for printing.  Pressing the Print  button will write the map
to a temporary file (permanent, if specified) and then invoke the ARC/INFO
printing interface.  Using the interface options select the printer Driver and
press Print .  The image, as viewed during preview, will be printed.
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Figure 3.13 Print Map window

Exiting HEC-GeoRAS

When finished editing coverages and viewing water surfaces return to the
project manager.  From the File menu on the HEC-GeoRAS Project
Manager select Exit .  Upon exiting, the user will always be asked to save
the current project.  The user will be returned to the ARC prompt.
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C H A P T E R  4

Using the Project Manager

The project manager window of HEC-GeoRAS is the initial window
available to the user.   The project manager allows the user to access
project management and data processing options.

This chapter discusses project management options and summarizes data
processing windows.

Contents

� Project Definition and the Default Directory

� Project Manager Options

Project Definition and the Default Directory

A complete project is the collection of all the GIS data necessary to create
an HEC-RAS import file and the converted HEC-RAS export file data for
inundation mapping.  Project pathnames are stored in an ascii file using
the .prj extension.  The user is not allowed to change to change the
extension.   The project file is composed of  the following:

Project Component Description

Project The project name.

DTM The Digital Terrain Model (DTM) for
the river network and channel
geometry.

Units The units of the project as read from the
DTM header.
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Contour Coverage The Contour Coverage constructed
from a DTM.

Main Channel Invert
Coverage

The line coverage of the river and reach
network.

Main Channel Banks
Coverage (optional)

The line coverage of the location of the
channel banks.

Flow Paths Coverage
(optional)

The line coverage of the hydraulic flow
path in the left overbank, main channel,
and right overbank.

Cross Section Cut Lines
Coverage

The line coverage of the location and
expanse of cross sections.

RAS Import File The data file created from extracting
geometric data from the DTM using the
RAS Coverages.

RAS Export File The file of water surface profiles and
bounding polygons formatted for import
into GIS.  Exported from RAS.

Water Surface Elevation
Coverage

A cross section cut line coverage
containing the elevation of the water
surface at each cross section for each
profile.

RAS Water Surface Profile
List

A list of the water surface profiles
exported from RAS.

GIS Water Surface Profile
List

A list of the water surface profiles
which have an associated inundation
coverage and depth grid.

Bounding Polygon Coverage The polygon coverage of the modeled
region for the given water surface.

Depth Grid The depth grid for the given water
surface profile.

The default project directory is the directory from which ARC/INFO is
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Figure 4-1 HEC-GeoRAS Project Manager options

initiated.  All coverages and files created are placed in the default
directory, unless the entire pathname is specified.

Project Manager Options

The project manager provides options from managing projects and
processing data.  The project manager is shown in Figure 4-1.
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Project Management

Projects are managed with options available from the File menu of the
project manager.  The options are listed:

File menu command Description

New Project Creates a new project.  Closes the current
project, prompting the user to save the
project, and then to enter the new project
name.

Open Project Opens an existing project.  Closes the
current project, prompting the user to
save the project if anything has been
changed. 

Save Project Saves the current  project.

Save Project As Saves the current project to a new
filename.  Prompts the user, if the new
name conflicts with an existing project.

Rename Project Allows the user to rename the current
project.

Delete Project Deletes the project file.  The user is
prompted for confirmation of deletion.

Command Line Returns the user to the ARC Prompt for
command line execution.  Type
&RETURN to return to the Project
Manager window.  Only very experienced
ARC/INFO users should use the
interactive Command Line option.

Exit Quits HEC-GeoRAS.
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Processing Windows

The project manager window allows access to preprocessing and
postprocessing windows.  The windows accessed are as follow:

Window Description

Create Contour Coverage Creates a contour coverage from a DTM. 
The user may supply the contouring
interval.  The default contouring interval
is one unit as read from the DTM.  Run
from ARC.

Create/Edit RAS
Coverages

Provides the user with arc editing tools
and an editing window to display
coverages.  Run from ARCEDIT.

Create RAS Import File Provides the user with a window that
displays the coverages to be used in
creating the import file.  Allows for the
user to select the cross section sampling
method.  Run from ARC.

Import RAS Export File Imports an HEC-RAS Export File
containing water surface profiles.  Allows
the user to select the file (*.gis) to import. 
Creates a coverage to hold water surface
elevations at each cross section and an
index file: tempindex9999.  Provides the
user with a menu to select the water
surface profiles to be created and the grid-
cell resolution for the associated depth
grid.  Creates the file wsp.menu in the
current workspace, from which the
window is invoked.  Creates the polygon
coverage with the prefix f_, the flow
depth grid prefixed d_, and the water
surface tin prefixed by t_ (later deleted). 
Run from ARCPLOT.
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Inundation Mapping Provides the user with a window for
displaying the extent and depth of
inundation for various water surface
profiles.  Creates the file wsp_draw.menu,
from which the window is invoked. 
Provides access to printing options.  Run
from ARCPLOT.
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Developing the HEC-RAS Import File

The HEC-RAS Import File consists of geometric attribute data necessary
to perform hydraulic computations in HEC-RAS.  The import file is
developed from an existing Digital Terrain Model (DTM) of the channel
and surrounding land surface.  Geometric data are extracted from the
DTM by locating the points of intersection of the RAS Coverages with the
DTM.  Currently, a triangulated irregular network (TIN) is the only
supported type of DTM.

RAS Coverages created by the user include coverages for the Main
Channel Invert, Main Channel Banks (optional),  Flow Paths (optional),
and Cross Section Cut Lines.  Data extracted from the DTM and RAS
Coverages form an import file which contains: river, reach, and station
identifiers; cross section cut lines; cross section surface lines; cross section
main channel bank stations; and downsteam reach lengths for the left
overbank, main channel, and right overbank.

At this time, channel and overbank roughness coefficients, hydraulic
structure data, and optional cross-section properties such as levees and
ineffective flow areas are not written to the import file.

Chapter 5 discusses the steps in developing the HEC-RAS Import File.

Contents

� Digital Terrain Model

� Creating the Contour Coverage

� Creating and Editing RAS Coverages

� Main Channel Invert Coverage

� Main Channel Banks Coverage

� Flow Paths Coverage

� Cross Section Cut Lines Coverage

� Creating a HEC-RAS Import File
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Digital Terrain Model

HEC-GeoRAS requires an existing DTM from which the geometric data
will be extracted.  Currently, a TIN representation must be used for the
DTM.   The DTM must be representative of both the land surface of the
surrounding floodplain and channel bottom.

Developing a hydraulic model begins with an accurate geometric
description of the surrounding landform, especially the channel geometry. 
Channel geometry will dominate flow in river systems; therefore, only
DTMs describing channel geometry with a high resolution should be
considered to perform hydraulic analysis.  Further, RAS Coverages
should be created with thoughtful evaluation of the hydraulics as governed
by the terrain.

Creating a Contour Coverage

Before creating a Contour Coverage, select the DTM using the browsing
button or right clicking over the Digital Terrain Model field and selecting
from the popup list.  Create a Contour Coverage from the DTM by
selecting Create Contour Coverage from the RASPrep menu on the
project manager.  Enter the name of the Contour Coverage and Contour
Interval in the form that appears (see Figure 5.1).  The contouring interval
should be selected based on the definition of the DTM.  Contouring
interval units are read from the DTM header and displayed below the
Contour Interval field.

It should only take a few minutes to create the Contour Coverage
depending on the Contour Interval and number of points in the DTM. 
The Contour Coverage is used to establish the geographic limits for
creating new coverages and to visually aid the user in properly drawing
the RAS Coverages.  The Contour Coverage is not used for data
extraction.
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Figure 5.1 Create contour coverage window

Creating and Editing RAS Coverages

Throughout this manual, the coverages used for extracting geometric
attribute data from the DTM are collectively referred to as RAS
Coverages.  The RAS Coverages are created by drawing arcs (lines) which
represent the geometric data needed to create a HEC-RAS model.  The
four RAS coverages are the Main Channel Invert, Main Channel Banks
(optional), Flow Paths (optional), and Cross Section Cut Lines.

Creating and editing the RAS Coverages is accomplished in ARCEDIT
using the Edit RAS Coverages window.  The editing environment is
accessed from the project menu by selecting Create/Edit RAS Coverages
from the RASPrep menu.  An editing window will appear to the right of
the Edit RAS Coverages window.  The windows may be moved, and the
editing window may be sized to the users preference. 

To import existing coverages, select them from the project manager before
accessing the coverage editing environment.  The coverages will be
imported into the editing environment as each coverage is selected for
editing. 
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Figure 5.2 Edit RAS Coverages window

Coverage Editor

The Edit RAS Coverages window is organized by function.  A menu bar at
the top of the window provides access to the File and Help menus.  The
upper portion of the window allows the user to select the type of coverage
to be edited and displays the entire pathname for the current edit coverage. 
The middle portion of the edit window provides the user with tools for
editing the RAS Coverages.  The bottom portion of the window allows the
user to display background coverages when editing a coverage. Editing
options are shown in Figure 5.2. 

 
Managing Coverages
Coverages are managed in the edit environment under the File menu, the
Edit type choices,  and the Cov. display field.

New, Open, Save, and Save As options are available from the File menu
option and cannot be used until a Edit type is chosen.  The Command Line
option and Exit are available under the File menu, as well.
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New: Creates a new coverage of the Edit type selected.  A message box
will allow the user to input the new coverage name.  If the name conflicts
with an existing coverage, the user will be prompted to overwrite the
existing coverage.  The coverage will be created in the default directory if
the entire pathname is not given.

Open: Opens an existing coverage.  The coverage is opened as the current
Edit type.

Save: Saves the current edit coverage. Operations are also performed on
the edit coverage which create nodes at intersecting arcs.  Dangling arcs
are created when an intersection is created and an arc overshoots the
intersecting node.  Dangling arcs should be removed from the Main
Channel Invert Coverage.

Save As: Saves the current edit coverage with the new name entered.  If
the name is in conflict with an existing coverage, the user will be prompted
to overwrite the existing coverage.  The coverage will be saved in the
default directory if an entire pathname is not given.

Command Line: Allows the user to provide line commands at the
ARCEDIT prompt.  Type &RETURN to return to the user interface.  This
option should only be used by experienced ARC/INFO users.

Exit : Quits from the editing environment and returns the user to the project
manager.

The Help menu allows the user to access online help using the Help and
ArcDoc options.

Help: Results in the display of a popup window with an ascii help file
specific to the editing window.

ArcDoc: Activates the ARC/INFO online help document.

Edit:   Allows the user to select the RAS Coverage type to edit.  If no
coverage has been entered in the corresponding text field on the project
manager, a new coverage of the Edit type will be created.  If the coverage
has been entered, it will be loaded as the current edit coverage and drawn
in the editing window at the full extent of the coverage.

Cov.: Displays the pathname of the current edit coverage. 
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Edit Tools
The edit tools allow the user to create and edit the RAS Coverages using a
mouse.  The edit coverage is displayed in black, while the currently
selected arcs are displayed in magenta.  The following edit options are
available:

SELECT One: Selects one arc to be edited. Use the left mouse button to
select an arc.  Select an arc before performing edits such as COPY,
DELETE, MOVE, etc ...

SELECT Many: Selects many arcs to be edited.  Use the left mouse
button to select arc.  When finished selecting arcs press, Ctrl + right mouse
button to exit.

SELECT All : Selects all the arcs in the edit coverage.

UNSELECT One: Unselects one arc.  Use the left mouse button to
unselect an arc.

UNSELECT Many : Unselects many arcs. Use the left mouse button to
unselect arcs. When finished unselecting arcs press, Ctrl + right mouse
button to exit.

UNSELECT All : Unselects all the arcs in the edit coverage.

SWITCH:  Switches the selection.  Unselected arcs are selected as selected
arcs are unselected.

ADD ARC: Adds an arc.  The right mouse button begins and ends an arc
by drawing a node.  The left mouse button draws a vertex.  An arc must be
composed of at least two nodes: a FROM node and a TO node.  Press  
Ctrl + right mouse button when finished. Arcs may contain no more than
500 points (498 vertices and 2 nodes).

MOVE : Moves the selected arc(s).  Use the left mouse button to drag and
drop the selection.
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COPY: Copies the selected arc(s).  The selection is copied parallel at the
position indicated by the cross-hairs by pressing the left mouse button.

DELETE : Deletes the selected arc(s).

SPLIT : Splits the selected arc into two arcs by placing a node at the
selected location.

UNSPLIT : Combines two arcs into one by removing a shared node.  If this
option does not combine the arcs, zoom in and check that the nodes lie on
top of each other (share the same point).  If the nodes do not share the
same point, use the MOVEVertex option to snap the nodes to the same
point.

FLIP : Reverse the direction of the selected arc(s) by reversing the FROM
and TO nodes.  Use the ARROWS option to determine arc orientation.

ARROWS : Indicates the direction the arc was constructed by placing an
arrow in the direction of the TO node.

EDIT NAMES : Edits the river and reach name of the selected arc.  River
reaches will be labeled and cross-hairs will appear to allow the user to
select the reach to edit.  The window shown in Figure 5.3 appears, after
selecting a river reach.  River and reach names must be 16 characters long
or less.  Reach names on the same river must be unique.  The ? button
provides a list of previously used river names which may be selected.  OK
accepts the entered names, dismisses the window, and saves the edit
coverage.  Cancel dismisses the window without changing the names. 
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Figure 5.3 Stream network editing window

MOVEVertex : Moves a vertex on the selected arc.  Select a vertex by
placing the cross-hairs over a vertex and pressing the left mouse button. 
Move the cross-hairs to the new location and press the left mouse button a
second time.  The cross-hairs will remain on the editing window allowing
the user to continue to move vertices.  If trouble is encountered, zoom in
on the vertex so that the exact location of the vertex may more easily be
selected.  Press the right mouse button when finished moving vertices.

ADDVertex: Adds a vertex to the selected arc.  Place the cross-hairs over
the location to add a vertex and press the left mouse button.  Cross-hairs
will remain allowing the user to continue to add vertices.  Press the right
mouse button when finished adding vertices.

DELETEVertex : Deletes a vertex from the selected arc.  Place the cross-
hairs over the vertex and press the left mouse button.  This option will also
delete a node making the vertex on the end the new node.  However, if an
node is on top of a vertex the user must delete both the node and vertex. 
Cross-hairs will remain, allowing the user to continue to delete vertices. 
Press the right mouse button when finished deleting vertices.

SNAPPING: Sets the node snap environment.  This option will invoke the
node snap environment window shown in Figure 5.4.  The snapping
tolerance determines the distance between nodes before they will snap
when drawing new arcs (or moving nodes and arcs) and is shown in the
units taken from the DTM header.  The WW button allows the user to set the
snapping tolerance visually in the editing window.   Node snapping may be
turned on or off.  The default is ON with the snapping tolerance set to
1/1,000 of the width or height, whichever is greatest, of the current edit
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Figure 5.4 Node Snap Environment window

coverage.  Press OK  to dismiss the window with the current node snap
environment. 

The node snap tolerance will determine the minimum allowable distance
between two nodes.  When a coverage is saved, any vertices or nodes that
are separated by less than the snap tolerance will snap together, altering the
construction of the corresponding arc.

UNDO: Undoes the last edit.  Undo keeps track of the edits since the
coverage was last saved.  Undo will not work with the EDIT NAMES
option. 

Display Coverages
To aid the user in creating and editing the Edit Coverage, coverages may
be displayed in the background of the editing window by selecting the
corresponding checkbox.  The empty input field allows the user to select a
background coverage other than the Contour Coverage and RAS
Coverages.  At this time, the background coverage must be a line
coverage.  Each coverage is displayed in a unique color as summarized
below.

Coverage Color

Current Edit Coverage Black

Main Channel Invert Blue

Bank Stations Red

XS Cut Lines Green

Overbank Flow Paths Blue

Ground Contours Grey
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Figure 5.5 Pan/Zoom menu options

Background Coverage Orange

Refresh Display:  Redraws the editing window, displaying the coverages
corresponding to the depressed checkboxes.  Maintains the current extent
and position of the of the editing window. 

Editing Window

There are several options available from the Pan/Zoom menu on the editing
window, shown in Figure 5.5 will be displayed.  The pan and zoom options
may be used in the middle of a editing operation such as ADD ARC.  After
execution of a menu option the editing window will be redrawn.   The
Pan/Zoom menu options are described below:

Create: Creates another window using the extent provided by the user. 
Use the left mouse button to select opposite corners of the extent to be
created.

Pan: Pans the view in the direction of the mouse.  Use the left mouse
button to pan.

Zoom In: Zooms in at the location of the mouse.  Use the left mouse
button to zoom.
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Zoom out: Zooms out at the location of the mouse.  Use the left mouse
button to zoom.

Zoom In Center: Zooms in to the center of the window by a factor of 2.

Zoom Out Center: Zooms out of the center of the window by a factor of
2.

Extent: Allows the user to specify the window extent (area to zoom into). 
Use the cross-hairs and left mouse button to select opposite corners of the
extent to be viewed.

Get Extent:  Prints the window extent to the ARCEDIT prompt.

Fullview: Displays the entire extent defined by the Contour Coverage.

Scale 1:1: Displays the window contents at a 1 to 1 scale. 

Redisplay: Redraws the editing display window.

The geospatial position of the cursor is also shown at the bottom of the
editing window in Windows NT and at the top on UNIX systems.  The
change in distance in the vertical direction and horizontal direction is
shown along with the total distance the cursor has moved from a specified
origin.  To select a specified origin, select the location with the mouse and
press the left or right mouse button.   The cursor position statistics
displayed on the ARCPLOT window are turned on and off using the
ARCWINDOWSTATS environment variable.

Main Channel Invert Coverage

The river and reach network is represented by the Main Channel Invert
Coverage. The network is created on a reach by reach basis, starting from
the upstream end and working downstream following the channel thalweg. 
Construct arcs with the TO node downstream of the FROM node (in the
direction of flow) as done in HEC-RAS.  Each reach is identified by a
River Name and a Reach Name.  A river is made up of one or more reaches
with the same River Name.  All reaches within a river must have unique
Reach Names.  Refer to the HEC-RAS User’s Manual, Chapter 6 for more
details.
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Creating the Network

Begin by selecting the MC Invert  choice from the Edit RAS Coverages
window.  In the response window, enter the name of the coverage to create
and press OK .  The name of the coverage may be no longer than 13
characters.  The blank coverage will be set as the coverage to edit. 

Each reach is represented by an arc.  To draw a reach, press the ADD
ARC button from the edit palette.  Place the mouse cursor at the upstream
end of the reach and press the right mouse button to “drop” a node.  Draw
the reach downstream stream using the left mouse button to create vertices
along the channel.  At the end of the reach, press the right mouse button to
create the end node.   After the end node is placed, a window will appear
to enter the River Name and Reach Name.  The river and reach names may
be 16 characters or less.  The ? button may be used to select a River Name

used previously in the Main Channel Invert Coverage.  The ? button will
only list the river names since the last save.

To begin a connected reach, press the right mouse button to create a new
node and begin to draw the reach downstream.  A junction is formed when
two or more nodes are placed one on top of another.  A least one of the
nodes must be the FROM node on the downstream reach.  Each reach may
be constructed with no more than 500 points.

It is recommended that the node snap tolerance be set by the user before
creating the stream network.  Greater snap tolerances ensure that reaches
are connected at junctions; however, snap tolerance that are too large will
create problems with nodes snapping to the wrong junction nodes.  Each
time that a coverage is Saved, nodes and vertices that are separated by less
than the node snap tolerance will be combined, thereby moving the
delineation of the main channel.  If this problem occurs, reduce the node
snap tolerance. 

Editing the river and reach network is accomplished using the editing tools
described earlier.  The EDIT NAMES option should be used to check that
the River Names and Reach Names are correctly named and that all reach
names within a river are unique.

Be sure to select MC Invert  from the Edit choice on the Edit RAS
Coverages window to indicate that the edit coverage is the Main Channel
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Figure 5.6 Main Channel Invert Coverage

Invert Coverage.  If another Edit choice is selected, the River Name and
Reach Name cannot be edited.

The Main Channel Invert Coverage is shown in Figure 5.6.   Ground
Contours displayed in the background, clearly delineate the main channel.
(Note that the “V” of the contours points in the upstream direction.) 
Reaches are separated by nodes, displayed in ARCEDIT as black squares.

Adding Reaches to an Existing Network

Adding a new reach to an existing river and reach network requires that a
reach be split.  To split a reach, select the reach and choose the SPLIT  arc
option from the Edit Tool palette.  Cross-hairs will appear for the user to
select the location to break the reach.  Press the left mouse button when
the location is selected.  The user will then be prompted to edit the reach
names of the two reaches and the selection cross-hairs will appear over the
editing window.  Select the first reach and edit or accept the Reach Name
and press OK .  Use the cross-hairs to select the second reach and edit or
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accept the Reach Name.  Pressing Cancel will keep the current names, as
will pressing OK  without making any edits.

Adding Tributaries to an Existing Network

After a reach is split, add a new reach using the ADD ARC  option.  Enter
the River Name and Reach Name at the window prompt.   To check that
the node of the new reach lies on top the node of the downstream reach,
zoom into the junction.  If the nodes are not aligned, the nodes can be
snapped together by moving the new reach or moving the end node of the
new reach.  The latter is suggested.  Select the new reach and choose the
MOVEV  (move vertex) button from the editing palette.  Select the TO
node with the cross-hairs and press the left mouse button.  Select the
FROM node of the downstream reach and press the left mouse button. 
Note that if the snapping tolerance had been greater than the separation of
the nodes, the nodes would have snapped on top of each other as the new
reach was created.

Merge Reaches in an Existing Network

 To merge two reaches into a single reach, they must share a node.  In other
words, the downstream node of the upstream river (TO node) must
coincide with the upstream node (FROM node) of the downstream river. 
To verify that two nodes are coincident, zoom into the nodes’ location and
move one of the nodes on top of the other while the SNAPPING option is
ON.

Select the two reaches to be joined and choose the UNSPLIT  option from
the Edit Tools palette.  One reach will be drawn to the screen (only two
nodes, instead of three) and the Name Stream Network window will
appear.  Enter the name of the newly formed reach and select OK . 
Pressing Cancel will keep the names displayed.

Main Channel Banks Coverage

The Main Channel Banks Coverage is a line coverage which indicates the
separation between the main channel and the overbanks and is used to
determine the main channel bank stations on the cross sections.  The Main
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Figure 5.7 Main Channel Banks Coverage

Channel Banks Coverage is optional.  To indicate bank positioning, use
the ADD ARC option from the Edit Tool palette and draw the position of
the bank stations for both sides of each river.

The bank lines may be broken and may cross where tributaries join a river
reach.  If two parallel bank lines are indicated (i.e., two broken bank lines
overlap), the bank stationing farthest from the river will be used. 
Orientation of the bank station lines is not important.  The Main Channel
Banks Coverage is shown in Figure 5.7, along with the main channel.

Flow Paths Coverage

The Flow Paths Coverage is used to determined the downstream  reach
lengths between cross sections in the left overbank, main channel, and right
overbank.  The Flow Paths Coverage is optional.
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Figure 5.8 Over Bank Flow Path Coverage

The coverage is created by using the ADD ARC  option to draw the
hydraulic flow paths in the left overbank, main channel, and right overbank. 
If the Main Channel Invert Coverage already exists, the main channel flow
path will be copied into the Overbank Flow Path Coverage and, therefore,
will not need to be created.  The three flow paths lines should not cross,
cross each cross section cut line exactly once, and be drawn in the direction
of flow (i.e., the TO node downstream of the FROM node).  The Overbank
Flow Path Coverage is shown in Figure 5.8. 

Cross Section Cut Lines Coverage

The location, position, and expanse of channel cross sections is represented
by the Cross Section Cut Lines Coverage.  The cross section cut lines are
used to extract the station and elevation data from the digital terrain model.

To draw a cross section cut line choose the ADD ARC option from the
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Figure 5.9 Cross Section Cut Line Coverage

editing pallete.  Press the right mouse button to place the FROM node and
draw the cut line to the TO node.  Press the right mouse button to end the
cut line.   Cross section cut lines are constructed with the FROM node at
the edge of the left overbank to the TO node at the edge of the right
overbank. Vertices may be placed between the FROM and TO node using
the left mouse button so that the cut line may be dog-legged perpendicular
to the direction of flow.  A cut line should cross a reach line exactly once,
and should not cross another cut line. 

The orientation of cut lines may be checked using the ARROWS option on
the Edit Tools palette.  When pressed, the ARROWS option places an
arrow at the TO node pointing in the direction the arc was created.  The
Cross Section Cut Line Coverage is shown in Figure 5.9 with the
ARROWS option turned on.  If the cut line was constructed in the
incorrect direction, use the FLIP  option to reverse the FROM and TO
node.  The FLIP option may be used on one or many arcs.
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Figure 5.10 Create RAS Import File window

Creating the HEC-RAS Import File

To create the HEC-RAS Import File, select Create RAS Import File from
the RASPrep menu on the project manager.  This will invoke a window
with input fields for the four RAS Coverages as shown in Figure 5.10.  The
user must have specified the Digital Terrain Model, a Main Channel Invert
Coverage, and a Cross Section Cut Line Coverage from the project
manager before attempting to create the import file.  The input fields for
the Main Channel Bank Stations Coverage and Overbank Flow Paths
Coverage may be left blank.

Select the sampling interval method.  The sampling method indicates where
the station and elevation data for cross sections will occur.  The default
method (Triangle Edges) samples the land-surface elevation at the edge of
each triangle in the TIN.  Choosing Select Interval allows the user to
specify a uniform distance between cross-section stations.  The units used
for the sampling are read from the DTM.

Enter the filename for the import file.  The extension .geo  will be added to
the filename.  The user is not allowed to change the extension.  Press
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Figure 5.11  RAS Coverage Status window

Create Import File when finished.  Cancel dismisses the window and
returns the user to the project manager.

Once the Create Import File button is pressed, the attributes of the RAS
Coverages will be checked for missing data.  Progress updates will be
displayed in the Create RAS Import File status window shown in Figure
5.11.

Coverage Checking

Before the RAS Import File is created, the RAS Coverages will be
checked.  As the coverages are checked, geometric attribute data will be
added or updated to the Cross Section Cut Line Coverage. The window
shown in Figure 5.11 will update to indicate the progress of the coverage
checking procedures.  The status messages that are updated to the window
and their meaning are listed below.  If any of the coverages were not
correctly created by the user, the checking procedure will be stopped and
the user informed of the missing coverage data.
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Message Meaning

Not Checked The corresponding attribute has not been
checked.

Checking The corresponding attribute is being
checked.

OK The coverage attribute was checked and
the appropriate coverage data is present.

Updating The attribute data is being updated.

Unmodified The coverage attributes present were not
updated since last attempt to create a RAS
Import File.

No Stations The Main Channel Banks Coverage is not
present.

No Reaches The Overbank Flow Paths Coverage is not
present.

Not Written The RAS Import File has not been written.

Writing The RAS Import File is being written.

River and Reach Network Attributes
The river and reach network attributes are checked first.  The checking
procedure looks to see that the Main Channel Invert Coverage has a River
and Reach Name for each reach in the coverage. Specifically, the checking
procedure looks to see that the arc attribute table (AAT) for the Main
Channel Invert Coverage contains the stream and reach items and that the
items are not blank.  STR_NAME and RCH_NAME are the default name
created when the Main Channel Invert Coverage is create in the edit
environment.  Reach uniqueness is not checked; therefore, it is
recommended that the user check the reach names prior to attempting to
create the RAS Import File.  If the River and Reach Names are not present,
the checking procedure will be aborted and the user will be informed to
edit the invert coverage river and reach names.

Cross section stationing is determined by dynamic segmentation of the
Main Channel Invert Coverage.  If this Route System is not present,
windows will direct the user to create one based on the lengths of the river
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arcs.  Two ARC/INFO tables are created named as the Main Channel
Invert Coverage name followed by .SECHECSTR and .RATHECSTR.  If
the Route System is already present, the user will be given the choice to
update the tables.

Cut Line Coverage Attributes
After the river and reach network attributes are checked, items are added
to the Cross Section Cut Line Coverage without user input.  The user will
only be prompted to update the tables, if the geometric attribute data are
already present.

Cross section stationing data are added to the STATION item.  If the
STATION item does not exist, it will be added.

Bank station data are contained by the items BANK1 and BANK2 (left and
right, respectively).  Bank Stations will not be added if the Main Channel
Banks Coverage has not been specified.  BANK1 and BANK2 are optional
items.

Reach length data are contained by RL1, RL2, RL3 (left bank, main
channel, and right overbank, respectively).  Reach lengths will not be added
if the Flow Paths Coverage has not been specified. RL1, RL2, and RL3 are
optional items.
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C H A P T E R  6

Viewing HEC-RAS Water Surface Profiles

HEC-GeoRAS facilitates the import of water surface profile data exported
from HEC-RAS results.  Inundation area and depth are calculated during
the import process and may be mapped using HEC-GeoRAS.  Mapping
options allow the user to view the extent of inundation for multiple profile
data and determine the depth of inundation for a given event.

Mapping functions are performed in ARCPLOT.

Chapter 6 discusses the options for viewing exported HEC-RAS water
surface profile data.

Contents

� Importing an HEC-RAS Export File

� Inundation mapping 

� Printing map results

Importing an HEC-RAS Export File

Water surface profile results exported from HEC-RAS are imported by
selecting Import RAS Export File from the RASPost menu on the
project manager.  The window shown in Figure 6.1 will be invoked,
allowing the user to select the file to be imported.  Right clicking over the
input box will allow the user to select from a popup list any file with the
.gis extension in the current directory, while pressing the button to the
right of the input field will invoke a file browser.

After selecting the import file, enter the name of a new cross section
coverage to create.  The new cross section coverage will contain the
geometric data from the RAS results.  Water surface elevations from the
user selected water surface profiles will be added to the new cross section
coverage during the import process.  
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Figure 6.2 Create Inundation Coverages/Grids window

Figure 6.1 Import RAS Export File window

Pressing OK  invokes the window shown in Figure 6.2 and allows the user
to select the water surface profile data to process.  The window also
allows the user to select the grid-cell resolution of the depth grid that will
be created.  Pressing OK  will create an inundation coverage and depth
grid for each water surface profile selected and dismiss the windows.

Two coverages will be created for each profile: a polygon coverage
having the prefix f_ and a depth grid having the prefix d_, followed by the
water surface profile name.  A water surface TIN having the prefix t_ will
be created but will be deleted after the water surface coverages have been



Chapter 6   Viewing HEC-RAS Water Surface Profiles

6-3

created.  Underscores will replace any blanks in the water surface profile
names.  The coverages are created in the current workspace.  The  files
wsp.menu, wsp_draw.menu, and  tempindex9999 will also be created in
the current directory during this process.  If the files already exist, they
will be overwritten.

Profile names must be 11 characters or less.  Inundation coverages will
not be created for profiles with name longer than 11 characters.

Inundation Mapping

To view the coverages created, select Inundation Mapping  from the
RASPost menu.  The Inundation Mapping window will be displayed
along with a display window.  The display window may be sized to the
user’s preference.

Mapping options are performed in ARCPLOT.

Inundation Mapping Menu

The Inundation Mapping window is organized by function. At the top of
the mapping window are the File and Help menus.   The upper portion of
the window allows the user to select the coverages and corresponding
colors to be displayed.   The lower part of the menu provides the user with
display window options.  The Inundation Mapping window is shown in
Figure 6.3.

File menu options include the Command Line, Print and Exit options,
while the Help menu provides online help for users.

Command Line: Allows the user to issue commands at the Arc Plot
prompt.  Type &RETURN to return to the user interface.

Print : Print provides options for printing inundation map results. 

Exit : Exit dismisses the mapping window and display and quits
ARCPLOT.  The user is returned to the project manger.

Help: Provides an ascii help file for mapping coverages.

ArcDoc: Provides access to the ARC/INFO help system.
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Figure 6.3 Inundation Mapping window

Coverage Display Options
Coverage display options allow the user to select the inundation extent
coverages, background coverages, and the depth grid to be displayed. 
Inundation polygons and depths grids cannot be displayed at the same
time.  The extent of inundation may be viewed as a filled polygon or as a
boundary polygon by selecting Fill  or Bndry, respectively.   These options
may be mixed and matched as desired.

To select the color for the extent of inundation coverages, press the 

button beside the profile name.  A color palette will be displayed.  If the
user dismisses the palette before choosing a color, no color will be
assigned to the coverage.

Selection of the depth grid is performed by right clicking in the input field
or typing the exact name.  A right click will result in a popup list from
which the depth grid may be selected.  Pressing the Depth? button will
allow the user to interactively determine the water depth at a given
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Figure 6.4 Inundation polygons

location.  The water depth and corresponding units will be displayed to
the right of the button.  Use the cross-hairs and left click to select the
location; right click to exit.

Background coverages may be displayed with the inundation coverages by
selecting the corresponding check box.  The Ground Contours, Main
Channel Bank Stations, and Main Channel Invert coverages are the
available background coverages, at this time.  Background coverages will
be displayed behind the inundation polygons but in front of the depth grid. 
Inundation mapping for exported water surfaces is shown in Figure 6.4.

Window Display Options
Window display options allow the user to update the content of the
display window.  The Display:  �Poly  �Grid choice determines whether
the inundation polygons or depth grid will be drawn to the display
window.  The polygons and depth grid may not be displayed
simultaneously.  The remaining display buttons are discussed below.
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Refresh Display: Refreshes the display window with the selected
coverage and display choice options.

ZoomIn: Zooms into the center of the window by a factor of 2.  Use the
left mouse button to select the location to zoomin to.  Right click when
finished zooming.

ZoomOut: Zooms out of the center of the window by a factor of 2. Use
the left mouse button to select the location to zoom to.  Right click when
finished zooming.

ZoomExtent: Allows the user to specify the extent of the view using
cross-hairs to select opposite corners.

FullView : Displays the entire extent of the coverage.

Pan: Allows the user to pan through the image without changing the scale
of the view. Use the left mouse button to select the location to pan to. 
Right click when finished panning.

For each option, a left click perform the operation and a right click quits.

Printing Map Results

Map results displayed in the Inundation Mapping window may be
modified and  printed from the Print Map window.  To access the Print
Map window show in Figure 6.5, select Print  from the File menu on the
Inundation Mapping window.  
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Figure 6.5 Print Map window

At the top of the Print Map window is a menu bar with the File and Help
menus.  The remainder of the menu is dedicated to modifying the page
and presentation of the inundation map for printing.

The File menu options include Preview, Print, Command Line, and Exit,
while the Help menu options provides access to online help.

Preview: Displays the entire page as it will be printed.  Shown in Figure
6.6 is an inundation map displayed using the preview option.

Print : Writes the map to a file and brings up the ARC/INFO printing
interface to print the map file.

Command Line:  Allows the user to issue commands at the ARCPLOT
prompt.  Type &RETURN to return to the user interface.  Only
experienced ARC/INFO users should use this option.
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Figure 6.6 Preview of an inundation map

Exit : Dismisses the Print Map window and returns control to the
Inundation Mapping window.

Help: Displays a help file specific to the printing options

ArcDoc: Accesses the ARC/INFO online help system.

Options provided to the user for modifying the page presentation include
the capabilities for selecting the page and page setup; displaying and
formatting text; displaying a border; and specifying and displaying the
map scale.  Viewing a map presentation before printing a map is
performed using the Preview, while the Print  option writes the map to a
file and accesses the ARC/INFO printing interface.

Page Setup
The type of paper currently selected for printing is displayed near the top
of the Print Map window in the Paper field.  To the right of the Paper
field is the Setup button.  Pressing the Setup button accesses the Page
Setup window shown in Figure 6.7.  The Page Setup window allows the
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user to identify the Paper and Orientation and specify the Page Margins
and Internal Margins.

Paper size options are provided for standard sizes.  The user may select
from the standard paper sizes listed by clicking the right mouse button
while the cursor is over the Paper input box.  The default paper size is
Letter, 8.5 x 11 in.

Paper Standard Size

Letter 8.5 x 11 in

Legal 8.5 x 14 in

B 11 x 17 in

C 17 x 22 in

D 22 x 34 in

E 34 x 44 in

F 44 x 68 in

Orientation choices are Portrait and Landscape.  Portrait specifies that
the first dimension listed after the name is the width of the paper while
Landscape specifies that the second dimension is the paper width. 
Portrait is the default paper orientation.

Page Margins indicate where the Border will be drawn, if so desired.  The
margins are be specified in inches from the papers edge.  One inch Page
Margins are the default.

Internal Margins determine the area available for the map to be displayed. 
The margins are specified in inches inside of the Page Margins.  The
default margins are 1.0 inch from the top page margin and 0.1 inch from
the remaining edges.

The OK  button applies the Page Setup setting and dismisses the window. 
Cancel dismisses the window without changing the setup.

Text
Text options allow the user to enter five labels and specify the format and
location of the text displayed.  The Text Fields on the Print Map window
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Figure 6.8 Text formatting window

allow the user to type in the labels for the map.  To enter a label, select a
text field using the left mouse button and begin typing.  Text with percent
signs (%) on each side is not allowed, while backward slashes (\) will
result in the text continuing on the next line, much like a carriage return. 
The corresponding checkboxes to the left of the Text Fields determine
which text will be displayed when the Preview and Print  option are used.

The position of the text may be specified by entering the coordinates
manually or by pressing the  button and selecting the text placement

with the cross-hairs provided.  The positioning of the text in relation to the
cross-hairs placement depends upon the justification setting for the text
field.

To format a text field press the Format Text button.  The window shown
in Figure 6.8 will be displayed.  The label text will be displayed on the
left portion of the window with the formatting value displayed in
corresponding fields to the right.

To select a Font, press the right mouse button over a selected font field to
invoke the list of available fonts, or type in the entire name into the field. 
At this time, Courier, Helvetica, Palacio (Palantino), and Times fonts are
available in normal, italic, bold, and bold italic.  Helvetica is the default.

Font Size may be specified by typing in the desired size.  Press the
carriage return after entering the size.  Size 16 pt font is the default.

Justification refers to the alignment of the label in relation to the cross-



Chapter 6   Viewing HEC-RAS Water Surface Profiles

6-11

hair position described earlier.  LEFT, CENTER, and RIGHT justification
choices are available.  LEFT justification means that the bottom left-hand
corner of the label will be located at the coordinate position shown on the
Print Map window, while CENTER means the text will be centered above
the position specified, and RIGHT means that the right-hand bottom
corner of the label will be located at the position specified.  Right click
over the Just. field to invoke a popup list or type in the justification choice
as listed above. 

OK  closes the Format Text Fields window, keeping any changes made.

Border 
To display a border when using Preview and Print  select the
corresponding checkbox.  The border will be drawn in black at the Page
Margins specified using Page Setup.

Map Scale
To display the map scale on the printed map, select the corresponding
checkbox.  The map scale will be printed at the bottom left-hand corner,
just below the border.  The Maximum Print Area choice is used to print
the map using the entire display area as determined from the Internal
Margins.  The User Defined Scale provides the user with a response
window for entering a specific scale.  The scale is defined as 1 inch to X
map units, where X is the scale and map units are determined from the
DTM.   The display area is reduced to fit the longest side of the map.

Preview
To preview the map before printing, use the Preview option from the File
menu.  During preview, the map displayed from the Inundation Mapping
window will be shown along with any items that have the corresponding
checkbox checked.

To change the map displayed during preview, select Exit  from the File
menu to return to the Inundation Mapping window.  From the Inundation
Mapping window the user may adjust the map view as desired, before
returning to the Print Map window.

Print
To print the map, select Print  from the File menu.  This will write the
map to a file before accessing the ARC/INFO printing interface.  If the
user wishes to save the map to a file, select the  Yes choice for Write map
to file?.   Otherwise, a temporary file tempprintfile.gra will be used to
print the map.
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From the printing interface select the file to print and printer Driver
(Window NT) or printer (UNIX) and press Print .  When finished printing
press Quit , to return to the Print Map window.

To print from UNIX, a print queue file must be setup. 

Exit
To exit from the Print Map window, select Exit  from the File menu.  The
user will be returned to the Inundation Mapping window.
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C H A P T E R  7

Example Application

This chapter provides an example application of how to integrate
ARC/INFO data sets with HEC-RAS using HEC-GeoRAS.  The user is
taken through a step by step procedure of how to develop an HEC-RAS
Import File and view water surface profile data exported from HEC-RAS.

To perform the steps taken in the example application, the user must have
an existing DTM of the river system to be modeled.  Chapters 4-6 provide
a more detailed discussion of the steps performed in the example.

Contents

� Starting a New Project

� Creating a Contour Coverage

� Creating RAS Coverages

� Creating a HEC-RAS Import File

� Running HEC-RAS

� Importing a HEC-RAS Export File

� Inundation Mapping

� Printing Map Results

� Exiting HEC-GeoRAS

Starting a New Project

Start up ARC/INFO and change directories to the workspace containing
your DTM.  To change workspaces use the WORKSPACE function just as
you would using cd at the UNIX or DOS prompt.  Type georas. The
project manager window, shown in Figure 7.1 will appear.
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Figure 7.1 HEC-GeoRAS Project Manager window

Begin a new project by selecting New Project from the File menu on the

project manager.  Enter the name of the new project in the response
window and press OK .  The name of the project will be displayed in the
Project field on the project manager.

Select the DTM using the browser or tight click over the Digital Terrain
Model field.  From the popup list, select the desired DTM with a left
click. 

Creating a Contour Coverage

A contour coverage must be created next.  It will be used to help you
create the RAS Coverages later.   Press the Create Contour Coverage
button on the project manager window.  The window shown in Figure 7.2
is invoked (except the Contour Coverage field will be blank).

Enter the Contour Coverage name and a Contour Interval and press
Create Contour Coverage.  Processing of the Contour Coverage will
take a few minutes, depending on the contouring interval and number of
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Figure 7.2 Create Contour Coverage window

points defining the DTM.  After the coverage is created, you will be
returned to the project manager.  The name of the Contour Coverage
created will be listed in the corresponding input field.

Create RAS Coverages

Access the coverage editing environment by pressing the Create/Edit
RAS Coverages button on the project manager window.  It will take a
few seconds for the editing environment to come up as ARCEDIT loads. 
The Edit RAS Coverages window, shown in Figure 7.3, will at last appear
with an editing window.  Resize the window as desired.

At this time, the editing window is blank.  Select the Ground Contours
checkbox on the Edit Ras Coverages window and press Refresh Display. 
The contours will be drawn in gray to the editing window.

The Edit RAS Coverages window and editing window will be used in
concert to create four coverages; Main Channel Invert, Main Channel
Banks, Overbank Flow Paths, and Cross Section Cut Lines.  The Main
Channel Banks and Overbank Flow Paths coverages are optional but will
be created in this example for completeness.
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Figure 7.3 Edit RAS Coverages window

Main Channel lnvert Coverage

As dictated by the Contour Coverage delineation, we are going to create
the two rivers, three reach system shown in Figure 7.4.  Select the MC
Invrt  choice on the top of the Edit RAS Coverages window.  Draw the
main channel invert by performing the following steps:

1. From the Pan/Zoom menu select Extent.  Use the left mouse
button to select opposite corners in the uppermost portion of the
river system to zoom into.

2. Press the ADD ARC button on the Edit Tools pallete.

3. Move the mouse pointer to the upstream most point of the first
river and press the right mouse button to place the FROM node. 
Begin moving downstream using the left mouse button to add
vertices along the reach.  As you run out of editing window space,
select Pan from the Pan/Zoom menu and left click in the direction
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Figure 7.4 River and reach network

you wish to pan (wherever the mouse is when you click will
become the new center of the editing window).  When you get to
the end of a reach, right click to place the TO node.

4. Once a reach is drawn, a window will prompt you to enter an
identifier for the River Name and Reach Name.  Each name is
limited to 16 characters, and all reach names for the same river
must be  unique.  In this example, the Wailupe River has two
reaches named  Upper and Lower and the tributary Kului Gorge
has one reach named Headwaters.  

5. Repeat steps 2-4 for each reach.  Be sure that the FROM node of
the "lower" reach is coincident with the TO node of the "upper"
reaches.  Zoom into each junction to check.

Several options are available from the Edit Tools palette to more
completely delineate the river network.  After coarsely delineating the
stream network, use the add, move, and delete vertex options to fine tune
each reach.  Lastly, use the EDIT NAMES  button to double check that
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Figure 7.5 Main Channel Banks Coverage

each Reach Name is unique.  Go to the File menu of the Edit RAS
Coverages window and select Save.

 Main Channel Banks Coverage

The next step is to establish the location of the main channel bank
stations.  Select the MC Banks choice from the top of the Edit RAS
Coverages window.  This will clear the Main Channel Invert Coverage
from the editing window.  Select the Main Channel Invert checkbox from
the Display Coverages portion of the edit window and press Refresh
Display.  This will redraw the main channel to the editing window in
blue.

Establish the bank station locations by using the ADD ARC option.  Use a
right click to drop the beginning node and use the left mouse button to add
vertices as you draw the location of the bank stations along one side of
one river.  At the end of the river, right click the mouse to place the end
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Figure 7.6 Overbank Flow Paths Coverage

node.  Establish bank station location lines for each side of each river
using the ADD ARC option, as shown in Figure 7.5.  After the bank
station locations have been defined, go to the File menu and select Save.

It is okay for bank station lines of a tributary to overlap with those of the
main river. 

 
Overbank Flow Paths Coverage

Now construct the Overbank Flow Paths Coverage, as shown in Figure
7.6.  Select the FlowPath choice from the Edit RAS Coverages window. 
The flow path for the main channel will be copied from the Main Channel
Invert Coverage, leaving only the flow paths in the overbanks to be
constructed.

Press the ADD ARC button and add the flow paths for the left and right
overbank. Use the right mouse button to begin the flow path at the
upstream end and continue downstream using the left mouse button to add
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vertices.  Use the right mouse button again to end the flow path.  To quit
drawing paths, press Ctrl + right mouse button.  Use the ARROWS
option to check that the flow paths point downstream.  After you have
finished all edits to the coverage, go to the File menu and select Save.

The overbank flow paths should be drawn to indicate the center of mass
for overbank flow during larger flow events.   The flow path coverage will
be used for determining downstream reach lengths between cross sections. 
It is okay for flow paths from tributaries to intersect with those of the
main stem.

 
Cross Section Cut Lines Coverage

The last coverage you need to create is the Cross Section Cut Line
Coverage.  Select the Cut Line choice from the Edit RAS Coverages
window.  Select the checkboxes for the Main Channel Invert, Main
Channel Bank Stations, Overbank Flow Paths, and Ground Contours and
press Refresh Display. 

Cross section cut lines are created from the left overbank to the right
overbank when looking downstream.  Press the ADD ARC button to
begin drawing the cut lines.  Position the mouse pointer on the left edge of
the left overbank and press the right mouse button to place the FROM
node.  Draw the cross section cut line across the floodplain using the left
mouse button to dog-leg the cut line perpendicular to the flow path lines.
Use the right mouse button to place the TO node at the end of the cut line. 
Continue adding cross section cut lines using the Pan/Zoom menu options
to change views.  Press Ctrl + right mouse button to finish adding cut
lines.  The Cross Section Cut Line coverage is shown in Figure 7.7 along
with the main channel flow paths and bank stationing.

To copy a cross section, go to the Edit Tools palette and press the
SELECT ONE option (SELECT MANY may be used, as well, if you
want to copy many cross sections).  Using the cross-hairs that appear, to
select the cross section cut line to copy.  Press the COPY button and
select the location to copy the cut line using the cross-hairs.  Press the left
mouse button, and the cut line will be copied.  The copied cross section
cut line will be drawn in magenta to the screen.
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Figure 7.7 Cross Section Cut Line Coverage

Move the cut line to the desired location using the MOVE  option.  Press
the MOVE  button, and use the pointer that appears to move the cut line to
the exact location.  Use the vertex options to reshape the cross section cut
line.

Lastly, use the ARROWS option to double check the cross section cut
lines were created from the left overbank to the right overbank.  If any cut
line is oriented backwards, select the cut line using the SELECT ONE
option and press the FLIP  button on the Edit Tools palette.  When
finished editing and checking the cut lines, go to the File menu and select
Save.

When finished creating the four RAS Coverages, select Exit  from the File
menu to quit from the Edit Coverage window. 



Chapter 7   Example Application

7-10

Figure 7.8 Create RAS Import File window

Creating a HEC-RAS Import File

Now that the RAS Coverages have been created, you are ready to create
the RAS Import File.  Press the Create RAS Import File button on the
project manager.  The window shown in Figure 7.8 will appear.  Enter the
name of the import file to create and press the Create Import File button.
The status window shown in Figure 7.9 will appear and be updated as the
attribute data for the RAS Coverages is checked.

Because the route system for the river network does not exist, you will be
prompted to establish river stationing.  The editing display window will
appear with the Main Channel Invert Coverage displayed.  One of the
rivers will be displayed in green and a message window will prompt you
to select the downstream most point in the reach.  Select the downstream
most point with the cross-hairs and press the left mouse button.  Next, a
window will allow you to enter the river station for that location.  Zero is
the default.  Enter the river stationing and press OK .  This procedure is
repeated for each river. 
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Figure 7.9 RAS Coverage Status window

After the RAS Import File has been created, a message window will
appear  informing you the file has been successfully created.  Press OK  to
dismiss the window.

Running RAS

To use HEC-RAS in concert with the GIS, perform the following steps:

1. Import the the RAS Import File into HEC-RAS from the Geometric
Data Editor.  

2. Complete the following hydraulic data: roughness coefficients,
expansion and contraction coefficients, and hydraulic structure
data.  For a more complete discussion on importing geometric data
refer to the HEC-RAS User’s Manual, Chapter 13.

3. Run simulations in HEC-RAS and review the output.  

4. Export the water surface profile results back to the GIS.  For a
more complete discussion on exporting GIS data refer to the HEC-
RAS User’s Manual, Chapter 13.
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Figure 7.10 Import GIS File window

Figure 7.11 Water surface profile selection window

Importing a HEC-RAS Export File

To begin the import procedure press the Import RAS Export File  button
from the project manager.  The window shown in Figure 7.10 will appear
allowing you to browse for the GIS file.  Select the file to import and
enter the name of a new coverage to be created.  The new coverage will
contain cross-section attribute data along with water surface elevations at
each cross section for each profile.  Press OK  to continue.
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Figure 7.12 Inundation Mapping window

Pressing OK  from the Import GIS File window will invoke a the Create
Inundation Coverages/Grids shown in Figure 7.11.  Select the checkboxes
corresponding to the water surface profiles you wish to view and enter the
resolution for the depth grid(s).  Press OK  to begin creating the water
surface coverages from the exported water surface profile data.  

You will be notified upon successfully creating the water surface profile
coverages.  Press OK  from the message window continue.

Inundation Mapping

The next step is to view the extent and depth of floodplain inundation. 
Press the Inundation Mapping button on the project manager.  The
window shown in Figure 7.12 will appear along with a display window.
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Figure 7-13 Water surface extent polygon coverage

Select the checkbox that corresponds to the event, ground contours, and
other background coverage(s) you wish to view and press the Refresh
Display button.  Shown in Figure 7.13 is a water surface flood extent
polygon displayed over the Ground Contours.

Next, select the depth grid that corresponds to the water surface you just
viewed. Right click over the Depth Grid input field and a list of available
grids will appear from which to choose. (You can also type the name of
the grid in the field.)   Select the depth grid and press OK .  To view the
depth grid, choose Depth Grid from the Display option and press the
Refresh Display button.  As shown in Figure 7.14, a blue-scaled grid will
be displayed, this time with the contours on top.  Darker blue indicates
greater inundation depths.  

Press the Depth? button to find out the depth of inundation at key
locations.  Cross-hairs will appear that allow you to left click at points
over the grid.  The depth at those points will be shown to the right of the
Depth? button.  Right click when finished determining depths.
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Figure 7.14 Shaded depth grid of floodplain inundation

Printing Map Results

Prepare the view you wish to print using the display options on the
Inundation Mapping window.  From the File menu select Print . The Print
Map window shown in Figure 7.15 will be invoked, although the text
fields will be blank.

Select the Border checkbox and press the Preview button.  The page, as it
will be printed will be drawn to the display window.  If the you wish to
change the inundation map, select Exit  from the File menu.  You will be
returned to the inundation mapping window to change the view.
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Figure 7.15 Print Map window

Select the desired page size, and margins using the Setup button to
activate the Page Setup window.  To change the page size, right click over
the Page Size field to invoke a select list. After leaving the Page Setup
window, press the Preview button to see the changes made to the page
setup.

Add a title to the map by typing in one of the text fields.  Use the cross-
hairs to position the text on the map, or enter the page coordinates
manually.  Press the Preview button to see how the text looks.  To format
the text use the Format Text button located beneath the text input fields.

Before printing, select the scale of the map.  To print the map scale on the
map, select the map scale checkbox.  Use the Preview option to see how
your map will look at the new scale.  An example map is shown in Figure
7.16.
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Figure 7.16 Preview of inundation map

When satisfied with your inundation map press the Print  button.  If you
elected to write the map to a file, your map will be written to the filename 
specified.  Otherwise, a temporary file will be created.  The ARC/INFO
print interface will then be invoked.  

The print interface for Windows NT differs from the UNIX interface.  For
Windows NT the following steps are required: (1) select the print Driver
and press Print  (if you did not elect to write the map to a file, the file
tempprintfile.gra will be selected as the file to print); (2) choose the
destination printer from the Windows NT print manager and press Print . 
For UNIX the following steps are required: (1) select the file to be printed
(if you did not elect to write the map to a file, the file tempprintfile.gra
will be selected as the file to print) and double click on the destination
printer; (2) edit the page attributes if desired and press Print .

When finished printing, choose Quit  from the ARC/INFO print interface
and select Exit  from the File menu on the Print Map window.  You will
be returned to the Inundation Mapping window.
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Exiting HEC-GeoRAS

When finished viewing water surfaces return to the project manager by
selecting Exit  form the File menu.  From the File menu on the HEC-
GeoRAS Project Manager select Exit .  Upon exiting, the user will always
be asked to save the current project.  The user will be returned to the Arc
prompt.



Appendix A - References

A-1

A p p e n d i x  A  

References

Environmental Systems Research Institute, 1998.  http://www.esri.com

Hydrologic Engineering Center, 1998. HEC-RAS, River Analysis System, User’s Manual, U.S.
Army Corps of Engineers, Davis, CA.



Appendix B - HEC-RAS Import/Export Files for Geospatial Data

%��

A p p e n d i x  B  

HEC-RAS Import/Export Files for
Geospatial Data

At version 2.0, HEC-RAS has introduced three-dimensional (3D)
geometry for the description of river networks and cross-sections.  This
capability makes it possible to import channel geometry from CADD or
GIS programs without conversion from real-world coordinates to station-
elevation descriptions for the cross-sections, as HEC-2 required. 
Similarly, water-surface elevations calculated at cross-sections can be
exported to CADD or GIS programs, where they can be used to create
model water surfaces for inundation mapping.

Supported HEC-RAS Data Exchange

Using a formatted ASCII text file, HEC-RAS will import a basic
description of the channel geometry including:

& The structure of the stream network, as represented by
interconnected reaches.

& The location and description of cross-sections.

Using the same file format, HEC-RAS can write a file exporting the
results of a hydraulic model run to a CADD or GIS program.  At a
minimum, reported results include the locations of cross-sections and the
calculated water-surface elevations at those cross-sections.

The Import/Export Data File Structure

This section gives general rules for the construction of an HEC-RAS
geometric data import or export file.  It is not necessary to understand all
these rules to build an import file, but they may be useful when debugging
failed imports.  The rules given here are a portion of the definition of a
general-purpose geometric data exchange format being developed at HEC
for its NexGen model programs.  Note: These file formats are evolving,
in that additional data types will be added, and some of the existing
ones may be modified for future versions.  If you are writing software
to read and write these file formats, please keep in mind that you may
need to modify your software to stay compatible with future versions
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of HEC-RAS.

Records and Keywords

The HEC-RAS geometric data import file is composed of records, which
in turn are composed of keywords and values.  All records must contain
one keyword, and all keywords end with a colon (:).  A record can also
contain a value or a set of values following the keyword, i.e., after the
colon.  Spaces, tabs, or line ends can be placed between a keyword and
values within a record.  

A record that contains a keyword and no value marks the beginning or the
end of a group of related records (for example, the record "BEGIN
HEADER:" marks the beginning of the header section of a data file).  A
record that contains a keyword and a value assigns that value to the part of
the model named by the keyword.

When a keyword is read, all spaces up to the colon are removed and all
letters are capitalized.  The keywords "Begin Header:", "Begin header:",
and " Be GiNH eadEr:" are all equivalent to "BEGINHEADER:".  For
readability, keywords named in this manual will contain internal spaces.

Values

A record can assign a single value to a single variable, or multiple values
to an array.  Values can be integers, floating point numbers, text strings,
or locations (X,Y,Z, label).  A single value in an array of values is called
an "element" of that array.

A numerical value (integer or floating point) cannot contain internal
blanks.  A floating point number can contain a decimal point; an integer
cannot.  Elements in an array of numerical values can be separated by
commas, blanks, tabs, or line ends.  

A text string can contain internal blanks, tabs, and commas, but cannot
contain internal line ends.  Elements in an array of text strings must be
separated by line ends.

A location consists of three coordinate values and a label (X, Y, Z, label).
The first two coordinates are planar, the third gives elevation.  The
coordinate values are floating point numbers, and the label can be any
type of value (although the label can be restricted to a particular data type
in a particular context). In certain contexts, the elevation value or the label
may not be required.  If a label is used, all three coordinate values must be
given; the value "NULL" is valid for the elevation coordinate only.  The
coordinate values and the label can be separated by commas, blanks, or
tabs, but a location cannot contain internal line ends.  Elements in an array
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of locations must be separated by line ends.

Data Groups

Records in the data file can be collected in two types of groups: objects
and file sections.  An object is a group of records that combine to describe
an entity within the model, a cross-section for example.  A file section is a
logical or functional grouping of data, the file header, for example, is a
section that contains a description of the whole file.  

Objects and file sections begin and end with records that contain
keywords, but no values.  A file section starts with a record containing a
keyword composed of the word "BEGIN" followed by the section name
and a colon, and ends with a keyword composed of the word "END"
followed by the section name and a colon.  For example, records
containing only the keywords "BEGIN HEADER:" and "END
HEADER:" are used to start and end the header section of a file.  An
object starts with a record containing a keyword naming the object type
and ends with a record containing the keyword "END:" only.  For
example, a cross-section object begins and ends with records containing
the keywords "CROSS-SECTION:" and "END:" only.  

Comments

Hash characters (#) are used to identify comments.  When a hash character
is encountered in the file, all data from the hash to the next line end are
ignored.  A line that begins with a hash is equivalent to a blank line.  

HEC-RAS Channel Geometry Import File

HEC-RAS reads channel geometry from a text file composed of  three
data sections:

1. A header, containing descriptions that apply to all data in the file.  
2. A description of the stream network, containing reach locations

and connectivity.  
3. A descriptions of the model cross-sections, containing their

location on the stream network and data required to support the
HEC-RAS model.  

An example HEC-RAS Channel Geometry Import file and HEC-RAS
model results export file is shown at the end of this appendix.
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BEGIN HEADER:
 UNITS: ENGLISH
END HEADER:

PLQLPXP LPSRUW ILOH KHDGHU

Header

The header is bounded by the records "BEGIN HEADER:" and "END
HEADER:" and must contain a record to identify the units system used in
the imported data set.  The units system can be ENGLISH or METRIC.  

Records that may be included in the header are listed in the Table B.1:

Table B.1

Keyword Value Type Value

UNITS: string ENGLISH or METRIC

PROFILES: string array List of profiles exported from HEC-RAS. 
Not used on import.

DTM TYPE: string type (e.g., TIN or raster)

DTM: string name of digital terrain model

STREAM LAYER: string name of stream layer in CADD or GIS

NUMBER OF REACHES integer number of hydraulic reaches contained in
the file.

CROSS-SECTION LAYER: string name of cross-section layer in CADD or
GIS

NUMBER OF CROSS-
SECTIONS:

integer number of cross sections in the file

MAP PROJECTION: string projection (coordinate) system used (e.g.,
STATEPLANE)

PROJECTION ZONE: string projection zone (if applicable, e.g., 5101)

DATUM: string reference datum for planar coordinates

VERTICAL DATUM: string reference datum for vertical coordinates
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BEGIN STREAM NETWORK:
  ENDPOINT: 476132.66, 65291.86, 155.28, 1
  ENDPOINT: 478144.53, 64296.61, 123.72, 2

  REACH:
    STREAM ID: Below Springfield
    REACH ID: Blue River
    FROM POINT: 1
    TO POINT: 2
    CENTERLINE:
      476132.66, 65291.86, 155.28, 23.13 
      476196.08, 65196.61, 154.47
       lines omitted
      478144.53, 64296.61, 123.72, 22.41
  END:
END STREAM NETWORK:

PLQLPXP LPSRUW VWUHDP QHWZRUN VHFWLRQ

Stream Network 

The stream network section is bounded by the records "BEGIN STREAM
NETWORK:" and "END STREAM NETWORK:" and contains records
describing reaches and reach endpoints.   At a minimum, the stream
network section must contain at least two endpoints and one reach.  The
minimum requirements for a stream network are shown below.

A reach endpoint is represented by a record containing the keyword
"ENDPOINT:" followed by four comma-delimited fields containing the
endpoint’s  X,Y,Z coordinates and an integer ID.  

A reach is represented by a multi-record object that begins with a record
containing only the keyword "REACH:" and ends with a record
containing only the keyword "END:."  At a minimum, a reach object must
contain records setting values for a stream ID, a reach ID, a FROM point,
and a TO point.  A reach’s FROM and TO point IDs must match IDs for
endpoints listed before the reach object in the file.  The reach object must
also contain an array of locations defining the stream centerline.  This
array begins with a record containing only the keyword "CENTERLINE:"
and ends when any keyword is encountered.  A location element in the
array contains the X, Y, and Z coordinates of a point on the stream
centerline, and the point’s river station.  In HEC-RAS, elevation and
stationing are optional in the stream network definition.  If a location
element includes a station value, it must occupy the fourth field in the
element.  If the elevation is not known, the word "null" must take its
place.  

Station values are assumed to be in miles for data sets in English units,
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and in kilometers for data sets in metric units.  Stationing is used for
indexing locations along reaches, and is not used to precisely locate
objects in the model.  

Records that may be included in a stream network section are listed in
Table B.2:

Table B.2

Keyword Value Type Value

ENDPOINT: location coordinates and integer ID

REACH: none marks beginning of reach object

END: none marks end of reach object

The following records are required for a reach object.

STREAM ID: string identifies reach’s membership in stream

REACH ID: string unique ID for reach within stream

FROM POINT: string integer reference to upstream endpoint

TO POINT: string integer reference to downstream endpoint

CENTERLINE: location
array

array elements contain coordinates and
(optionally) floating point station value. 

Cross-Sections

The cross-section file section begins with a record containing the only the
keyword "BEGIN CROSS-SECTIONS:" and ends with a record containing
the only the keyword "END CROSS-SECTIONS:."  A cross-section is
represented by multi-record object beginning with a record containing only
the keyword "CROSS-SECTION:" and ending with a record containing only
the keyword "END:." 

 
A cross-section object must include records identifying the stream, reach, and
station value of the cross-section, a 2D cut line, and a series of 3D locations
on the cross-section.  Stationing is given in miles for data sets with plane units
of feet and in kilometers for data sets with plane units of meters.  A cut line is
composed of the label "CUT LINE:" followed by an array of 2D locations.  A
cross-section polyline consists of the label "SURFACE LINE:" plus 3D
coordinates written as comma-delimited X,Y,Z real-number triples, one triple
to a line.
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Records that may be included in the cross-section file section are listed in
Table B.3:

Table B.3

Keyword Value Type Value

CROSS-SECTION: none marks beginning of cross-section object

END: none marks end of cross-section object

The following records are required for a cross-section object.

STREAM ID: string identifiers for stream and reach where cross-
section is located (must refer to existing
streams and reaches in the model)REACH ID: string

STATION: floating point relative position of cross-section on stream

CUT LINE: location
array

array elements contain 2D coordinates of
cross sectione stike line

SURFACE LINE: location
array

array elements contain 3D coordinates of
cross section points

The following records are optional for a cross-section object.

BANK POSITIONS: floating point
(2 elements)

Fraction of length along cut line where main
channel bank stations are located.  (values 0.0
- 1.0)

REACH LENGTHS: floating point
(3 elements)

Distance along left overbank, center channel,
and right overbank flow paths to next cross-
section downstream (units are feet or meters).

WATER ELEVATION: floating point
array

Water surface elevation values.  Used for
export of model results.  Not read on import.

HEC-RAS Model Results Export File

HEC-RAS exports model results to a text file using the same format as the
data import file.  The contents of the files, however, are not identical.  The
stream network section is not required for data export, and the surface line
may be omitted from the cross-section objects.  An example HEC-RAS
model export file is shown at the end of this discussion.  Model results are
reported with the following elements (Table B.4), which are not required
(and are not read) in the import file.
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Table B.4  

Keyword Value Type Value

The following record is optional in the Header section of the export file.

PROFILE NAMES: string array name(s) of water surface profiles reported in
the file.  This record is required if more than
one profile is reported.

The following record is required for each cross-section object.

WATER ELEVATIONS: floating point
array

Elevation of water surface at the cross-
section.  The array must contain one value for
each profile.

The following records make up a section defining a bounding polygon of the water surface
limits. 

BEGIN BOUNDARIES: none Marks start of boundaries file section.

END BOUNDARIES: none Marks end of boundaries file section.

PROFILE LIMITS: none Marks start of an object defining the limits of
a single water surface profile.

PROFILE ID: string Name of profile.  This must match a name in
the Profile Names record in the header.

POLYGON location
array

A series of 2D locations marking the limits of
a water surface.  A single profile limit can be
merged from multiple polygons.

1. Profile names can contain up to 11 characters for HEC-
GeoRAS.  They must begin with a letter.

2. If no profile name is provided, only one water elevation will be
written for each cross section.

Water Surface Bounding Polygon

In addition to a water surface elevation at each cross section (one for each
profile), the HEC-RAS program sends a bounding polygon for each
hydraulic reach in the model (the program outputs a new set of bounding
polygons for each profile computed).  The bounding polygon is used as an
additional tool  in assisting the GIS (or CADD) software to figure out the
boundary of the water surface on top of the terrain. 

In most cases, the bounding polygon will represent the outer limits of the
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cross section data, and the actual intersection of the water surface with the
terrain will be inside of the polygon.  In this case, the GIS software will
use the water surface elevations at each cross section and create a surface
that extends out to the edges of the bounding polygon.  That surface is
then intersected with the terrain data, and the actual water limits are found
as the location where the water depth is zero.

However, is some cases, the bounding polygon may not represent the
extents of the cross-section data.  For example, if there are levees
represented in the HEC-RAS model, which limit the flow of water, then
the bounding polygon will only extend out to the levees at each cross
section.  By doing this, when the information is sent to the GIS, the
bounding polygon will prevent the GIS system from allowing water to
show up on both sides of the levees.

In addition to levees, the bounding polygon is also used at hydraulic
structures such as bridges, culverts, weirs, and spillways.  For example, if
all of the flow is going under a bridge, the bounding polygon is brought
into the edges of the bridge opening along the road embankment on the
upstream side, and then back out to the extent of the cross-section data on
the downstream side.  By doing this, the GIS will be able to show the
contraction and expansion of the flow through the hydrualic structures,
even if the hydraulic structures are not geometricaly represented in the
GIS.

Another application of the bounding polygon is in FEMA floodway
studies.  When a floodway study is done, the first profile represents the
existing conditions of the flood plain.  The second and susequent profiles
are run by encroaching on the floodplain until some target increase in
water surface elevation is met.  When the encroached profile is sent to the
GIS, the bounding polygon is set to the limits of the encroachment for
each cross section.  This will allow the GIS to display the encroached
water surface (floodway) over the terrrain, even though the water surface
does not intersect the ground.

Import/Export Guidelines

The following rules apply to channel and cross-section import/export data.

Defining The Stream Network

1. The stream network is represented by a set of interconnected
reaches.  A stream is a set of one or more connected reaches that
share a common stream ID.
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2. A stream is composed of one or more reaches with the same
stream ID, and each reach in a stream must have a unique reach
ID.  Every reach must be identified by a unique combination of
stream and reach IDs.

3. Stream IDs and Reach IDs are alphanumeric strings up to 16
characters long.  Reach endpoint IDs are integers.

4. Streams cannot contain parallel flow paths.  (If three reaches
connect at a node, only two can have the same stream ID.)  This
prevents ambiguity in stationing along a stream.

5. A reach is represented by an ordered series of 3D coordinates, and
identified by a stream ID, a reach ID, and IDs for its endpoints.  

6. A reach endpoint is represented by its 3D coordinates and
identified by an integer ID.

7. Reaches are not allowed to cross, but can be connected at their
endpoints (junctions) to form a network.  

8. The normal direction of flow on a reach is indicated by the order
of its endpoints.  One point marks the upstream or "from" end of
the reach, the other marks the downstream or "to" end of the reach. 

Defining Cross-Sections

1. Each cross-section is defined by a series of 3D coordinates, and
identified by a stream name and reach name (which must refer to
an existing stream and reach) and a station, indicating the distance
from the cross-section to the downstream end of the stream. 

2. Stationing is given in miles for projects using English units and in
kilometers for projects using metric units.  

3. A cross-section line can cross a reach line exactly once, and cannot
cross another cross-section line.  

Results of a water surface calculation are exported in a file that contains
cross-section locations in plane (2D) coordinates, water-surface elevations
for the cross-sections, and boundary polygons for the reaches.  
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The Following Rules Apply to Water-Surface Export Data

1. A cross-section is represented by a water surface elevation and a
series of 2D coordinates on the cross-section cut line.  The full
width of the cross-section is included.

2. One bounding polygon is created for each reach in the stream
network, and for each profile.

3. A reach’s bounding polygon is made up of the most upstream
cross-section on the reach, the endpoints of all cross-sections on
the reach, and the most upstream cross-sections of reaches
downstream of the reach.

4. For purposes of defining bounding polygons only, the endpoints of
a cross-section are adjusted to the edge of the water surface at the
cross-section if the cross-section is part of a floodway, a leveed
section of the reach, or the water extent is controlled by a
hydraulic structure.  This allows calculated water surfaces that are
higher than the land surface to be reported back to the CADD or
GIS program.
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Sample HEC-RAS Geometry Import File
BEGIN HEADER:

  DTM TYPE: TIN
  DTM: /HEC63/USR1/EVANS/WAILUPE/WAI_TIN (TIN)
  STREAM LAYER: /HEC63/USR1/EVANS/WAILUPE/WAI_STR
  NUMBER OF REACHES: 3
  CROSS-SECTION LAYER: /HEC63/USR1/EVANS/WAILUPE/WAI_XS
  MAP PROJECTION: STATEPLANE
  PROJECTION ZONE: 5101
  DATUM: NAD27
  UNITS: ENGLISH

END HEADER:

BEGIN STREAM NETWORK:

  ENDPOINT:   582090.19,    49360.46,   220.17, 1
  ENDPOINT:   583638.69,    47559.38,   266.80, 2
  ENDPOINT:   582307.31,    46985.66,   112.84, 3
  ENDPOINT:   584128.44,    41274.97,    -3.41, 4

  REACH:
    STREAM ID: Kulai Gorge
    REACH ID: Headwaters
    FROM POINT: 2
    TO POINT: 3
    CENTERLINE:
      583638.69,    47559.38,  266.80,    0.33
     11 lines omitted
      582307.31,    46985.66,  112.84,    0.00
  END:

  REACH:
    STREAM ID: Wailupe
    REACH ID: Upper
    FROM POINT: 1
    TO POINT: 3
    CENTERLINE:
      582090.19,    49360.46,  220.17,    1.65
     14 lines omitted
      582307.31,    46985.66,  112.84,    1.19
  END:

  REACH:
    STREAM ID: Wailupe
    REACH ID: Lower
    FROM POINT: 3
    TO POINT: 4
    CENTERLINE: 
      582307.31,     46985.66,   112.84,   1.19
     33 lines omitted
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      584128.44,     41274.97,        -3.41,      0.00
  END:

END STREAM NETWORK:

BEGIN CROSS-SECTIONS:

  CROSS-SECTION:
    STREAM ID: Kulai
    REACH ID: Headwaters
    STATION: 0.312
    BANK POSITIONS:  0.5562,  0.6294
    REACH LENGTHS:   84.541,  89.110,  82.013
    CUT LINE:
      583613.16,     47441.98
      583567.80,     47529.68
      583558.73,     47575.04
      583567.80,     47638.55
    SURFACE LINE:
      583613.16,     47441.98,      309.69 
     29 lines omitted
      583567.80,    47638.55,      278.10
  END:

6 Cross-Sections omitted
 
  CROSS-SECTION:
    STREAM ID: Kulai
    REACH ID: Headwaters
    STATION: 0.019
    BANK POSITIONS:  0.4454,  0.4799
    REACH LENGTHS:   187.942, 193.195, 163.246
    CUT LINE:
      582769.62,     46950.81
      582598.07,     46978.64
      581981.41,     47224.45
    SURFACE LINE:
      582769.62,    46950.81,      167.62
     78 lines omitted 
      581981.41,    47224.45,      169.89
  END:

  CROSS-SECTION: 
    STREAM ID: Wailupe
    REACH ID: Upper
    STATION: 1.629
    BANK POSITIONS:  0.4781,  0.5615
    REACH LENGTHS:   55.965,  53.626,  40.370   
    CUT LINE:
      582159.78,     49259.60
      582013.48,     49223.76
    SURFACE LINE:
      582159.78,    49259.60,      235.49
     29 lines omitted
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      582013.48,    49223.76,      241.78
  END:

7 Cross-Sections omitted

  CROSS-SECTION: 
    STREAM ID: Wailupe
    REACH ID: Lower
    STATION: 1.183
    BANK POSITIONS:  0.5236,  0.5686
    REACH LENGTHS:   171.000, 164.796, 159.249
    CUT LINE:
      582723.17,     46846.45
      582426.44,     46878.92
      581953.51,     47082.99
    SURFACE LINE:
      582723.17,    46846.45,      161.92
     70 lines omitted
      581953.51,    47082.99,      165.01
  END:

23 Cross-Sections omitted
 
  CROSS-SECTION: 
    STREAM ID: Wailupe
    REACH ID: Lower
    STATION: 0.037
    BANK POSITIONS:  0.5034,  0.5155
    REACH LENGTHS:   82.365,  192.982, 137.742
    CUT LINE:
      586214.12,     42127.92
      581980.99,     40806.06
    SURFACE LINE:
      586214.12,    42127.92,        4.01
     71 lines omitted
      581980.99,    40806.06,        6.39 
  END:

END CROSS-SECTIONS:

FILE COMPLETE: 28 October 1996,  17:17
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Sample HEC-RAS Geographic Data Export File

BEGIN HEADER:

# RAS output file created 29 Oct 96 16:36:41 Tuesday
# by HEC-RAS
  NUMBER OF REACHES: 3
  NUMBER OF CROSS-SECTIONS: 46
  NUMBER OF PROFILES: 2
  MAP PROJECTION: STATEPLANE
  PROJECTION ZONE: 5876
  DATUM: NAD27
  PLANE UNITS: FEET
  ELEVATION UNITS: FEET
  STATION UNITS: MILES
  PROFILE NAMES: PF#1, PF#2

END HEADER:

BEGIN CROSS-SECTIONS:

  CROSS-SECTION:
    WATER ELEVATIONS: 265.8189, 268.7436
    CUT LINE:
      583613.16,   47441.98 
      583567.80,   47529.68 
      583558.73,   47575.04 
      583567.80,   47638.55 
  END:

  CROSS-SECTION:
    WATER ELEVATIONS: 257.7377, 270.6435
    CUT LINE:
      583537.56,   47429.88
      583474.05,   47529.68
      583474.05,   47568.99
      583492.20,   47662.74
  END:

119 cross-sections omitted

  CROSS-SECTION:
    WATER ELEVATIONS: 5.964032, 6.43543
    CUT LINE:
      586202.53,   42188.21 
      583941.76,   41483.75
      581932.30,   40961.43 
  END:

  CROSS-SECTION:
    WATER ELEVATIONS: 5.662289, 6.12576
    CUT LINE:
      586214.12,   42127.92 
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      581980.99,  40806.06 
  END:

END CROSS-SECTIONS:

BEGIN BOUNDS:

  PROFILE LIMITS:
    PROFILE ID:PF#1
    POLYGON:
      582013.48 , 49223.76 
          63 lines omitted
      581819.14 , 49209.56 

    POLYGON:
      581953.51 , 47082.99 
    141 lines omitted
      581934.965 , 47008.78 

    POLYGON:
      583567.8 , 47638.55 
    43 lines omitted
      583530 , 47650.645 
  END:

  PROFILE LIMITS:
    PROFILE ID:PF#2
    POLYGON
      582013.48 , 49223.76 
          63 lines omitted
      581819.14 , 49209.56 

    POLYGON:
      581953.51 , 47082.99 
    141 lines omitted
      581934.965 , 47008.78 

    POLYGON:
      583567.8 , 47638.55 
    43 lines omitted
      583530 , 47650.645 
  END:

END BOUNDS:

#FILE COMPLETE: 17 Jan 97 16:38:04 Friday
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A p p e n d i x  C  

RAS Coverage Data Structure

Main Channel Invert  

The Main Channel Invert Coverage is used to define the location of the
river channel and to establish the river and reach network.  River and reach
names are defined by the user and written to the STR_NAME and
RCH_NAME items, respectively.  Coverage items written to the arc
attribute table (AAT) are listed below.

Item Type Outpu
t

Description

Cover# B 5 Generated by ARC/INFO

Cover-ID B 5 Generated by ARC/INFO

LENGTH F 18 Generated by ARC/INFO, length
of cut line

STR_NAME C 16 Created by HEC-GeoRAS, user
defined value for river

RCH_NAME C 16 Created by HEC-GeoRAS, user
defined value for reach

Dynamic segmentation information for the Main Channel Invert Coverage
is written to the route table .RATHECSTR and section table
.SECHECSTR.
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Item Type Outpu
t

Description

HECSTR# B 5 Generated by ARC/INFO

HECSTR-ID B 5 Generated by ARC/INFO

STREAMID C 16 Generated by ARC/INFO

.SECHECSTR

Item Type Outpu
t

Description

ROUTELINK# B 5 Generated by ARC/INFO

ARCLINK# B 5 Generated by ARC/INFO

HECSTR# B 5 Generated by ARC/INFO

HECSTR-ID B 5 Generated by ARC/INFO

T-MEAS F 12 Generated by ARC/INFO

F-MEAS F 12 Generated by ARC/INFO

T-POS F 12 Generated by ARC/INFO

F-POS F 12 Generated by ARC/INFO

Cross Section Cut Line

The Cross Section Cut Line Coverage is used to determine the location and
expanse of each cross section.  All attribute data are attached to this
coverage in the AAT before the RAS Import File is written.

Item Type Outpu
t

Description

Cover# B 5 Generated by ARC/INFO

Cover-ID B 5 Generated by ARC/INFO
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LENGTH F 18 Generated by ARC/INFO, length
of cut line

STR_NAME C 16 Created by HEC-GeoRAS, user
defined value for river name

RCH_NAME C 16 Created by HEC-GeoRAS, user
defined value for reach name

STATION F 12 Created by HEC-GeoRAS, defines
the cross-section stationing

BANK1 F 7 Created by HEC-GeoRAS, defines
percent distance to left bank
station along cut line from left end

BANK2 F 7 Created by HEC-GeoRAS, defines
percent distance to right bank
station along cut line from left end

RL1 F 12 Created by HEC-GeoRAS, defines
downstream reach length for left
overbank

RL2 F 12 Created by HEC-GeoRAS,
defines downstream reach length
for main channel

RL3 F 12 Created by HEC-GeoRAS, defines
downstream reach length for
right overbank

Main Channel Banks

The Main Channel Banks Coverage is used to determine bank station
locations for each cross section. The following attributes are written to the
Main Channel Banks AAT.
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Item Type Outpu
t

Description

Cover# B 5 Generated by ARC/INFO

Cover-ID B 5 Generated by ARC/INFO

LENGTH F 18 Generated by ARC/INFO, length
of arc

Flow Paths

The Flow Path Coverage is used to determine downstream reach lengths
for each cross section.  The following attributes are written to the Flow
Paths AAT.

Item Type Outpu
t

Description

Cover# B 5 Generated by ARC/INFO

Cover-ID B 5 Generated by ARC/INFO

LENGTH F 18 Generated by ARC/INFO, length
of arc

STR_NAME C 16 Copied from the Main Channel
Invert Coverage (if it exists) in
HEC-GeoRAS

RCH_NAME C 16 Copied from the Main Channel
Invert Coverage (if it exists) in
HEC-GeoRAS


